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Acronyms in This Document

A list of acronyms used in this document.

Acronym Definition

AXI Advanced Extensible Interface
CNN Convolutional Neural Network
DRAM Dynamic Random Access Memory
EVDK Embedded Vision Development Kit
FPGA Field-Programmable Gate Array
LED Light-Emitting Diode

NN Neural Network

SD Secure Digital

SPI Serial Peripheral Interface

SRAM Static Random Access Memory
VIP Video Interface Platform
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1. Introduction

This document describes the Human Counting Design process of Resnet using the ECP5™ Embedded Vision
Development Kit FPGA platform. Human Counting is a subset of the generic Object Counting base design.

1.1. Design Process Overview
The design process involves the following steps:
1. Training the model
e Setting up the basic environment
e  Preparing the dataset
e Preparing 224 x 224 image
e Labeling dataset of human bounding box
e  Training the machine
e Training the machine and creating the checkpoint data
e Creating the frozen file (*.pb)
2. Compiling Neural Network
e  Creating the binary file with Lattice SensAI™ 3.0 program
3. FPGA Design
e Creating the FPGA bitstream file
4. FPGA Bitstream and Quantized Weights and Instructions
e  Flashing the binary and bitstream files
e Binary File to MicroSD
e  Bitstream to Flash Memory on VIP Board

m— : NN Compiler
Training ) o Quantized Weights
Dataset Trained ‘@-m-u-= | _and Instructions
Model - |

Training
Scripts * ML Frameworks

Training Model Lattice FPGA

FPGA
" DIAMOND Bitstream
Interface
FPGA FPGA Tools

Design

Figure 1.1. Lattice Machine Learning Design Flow
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2. Setting Up the Basic Environment

2.1. Software and Hardware Requirements

This section describes the required tools and environment setup for FPGA bitstream and flashing.

2.1.1. Lattice Software

e Lattice Diamond® — Refer to http://www.latticesemi.com/latticediamond.
e Llattice Diamond Programmer — Refer to http://www.latticesemi.com/programmer.

e Lattice SensAl Compiler v3.0 — Refer to
https://www.latticesemi.com/Products/DesignSoftwareAndIP/AIML/NeuralNetworkCompiler.

2.1.2. Win32 MicroSD Disk Imager
Refer to https://sourceforge.net/projects/win32diskimager/.

2.1.3. Hardware

This design uses the ECP5 FPGA VIP Board as shown in Figure 2.1. Refer to
http://www.latticesemi.com/Solutions/Solutions/SolutionsDetails02/VIP.

CrossLink VIP
Input Bridge Board

ECP5 VIP
Processor Board

HDMI VIP Output
Bridge Board

Camera Sensor CN2

Camera Sensor CN1

MicroSD Card
Adapter Board

Figure 2.1. Lattice EVDK with MicroSD Card Adapter Board

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.

10 FPGA-RD-02195-1.0


http://www.latticesemi.com/legal
http://www.latticesemi.com/latticediamond
http://www.latticesemi.com/programmer
https://www.latticesemi.com/Products/DesignSoftwareAndIP/AIML/NeuralNetworkCompiler
https://sourceforge.net/projects/win32diskimager/
http://www.latticesemi.com/Solutions/Solutions/SolutionsDetails02/VIP

.I.ILATTICE Object Counting Using Resnet CNN Accelerator IP

Reference Design

2.2. Setting Up the Linux Environment for Machine Training

2.2.1. Installing the CUDA Toolkit

To install the CUDA toolkit, run the following commands in the order specified below:

$ curl -0
https://developer.download.nvidia.com/compute/cuda/repos/ubuntul604/x86 64/cuda-
repo-ubuntul604 10.1.105-1 amd64.deb

(base) sib:~/kishan$ curl -0 https://developer.download. nvidia. com/compute/cuda/repos/ubuntul604/x86_64/cuda-repo-ubuntuléd 10.1,105-1 amd6d. deb
¥ Total % Received % Xferd Average Speed Time  Time Time Current
Dload Upload Total Spent  Left Speed
108 2832 100 2832 @ g 514 @ 0:00:05 0:00:05 --:--:-- 584
(base) sib:~/kishan$ _

Figure 2.2. CUDA Repo Download
$ sudo dpkg -I ./cuda-repo-ubuntul604 10.1.105-1 amdé64.deb

(base) sib:~/kishans sudo dpkg -1 ./cuda-repo-ubuntuls®d_10.1.105-1_amdsd. deb
Selecting previously unselected package cuda-repo-ubuntulsdd.

(Reading database ... 288236 files and directories currently installed.)
Preparing to unpack .../ cuda-repo-ubuntule®d_10.1.105-1 amdsd.deb ...
Unpacking cuda-repo-ubuntuledd (10.1.105-1) ...

Setting up cuda-repo-ubuntulédd (10.1.105-1) ...

(base) sib:~/kishans _

Figure 2.3. CUDA Repo Installation

$ sudo apt-key adv —--fetch-keys
http://developer.download.nvidia.com/compute/cuda/repos/ubuntul604/x86 64/7fa2af80.
pub

(base) sib:~/kishan$ sudo apt-key adv --fetch-keys http://developer.download. nvidia. con/compute/cuda/repos/ubuntu1604/x86_64/7fa2af86. pub
Executing: gpg --ignore-time-conflict --no-options --no-default-keyring --homedir /tmp/tmp.ogotakicGnd --no-auto-check-trustdb --trust-model
ng /etc/apt/trusted.gpg --keyring Jetc/apt/trusted.gpg.d/diesch-testing.gpg --keyring /etc/apt/trusted. gpg.d/george-edisonSs-cnake-3_x.gpg -
--fetch-keys http://developer.download.nvidia. con/compute/cuda/repos/ubuntul604/x86_64/7fa2af8. pub

pg: Key TFA2AF86: "cudatools <cudatools@nvidia.com>" not changed

gpg: Total number processed: 1

pg: unchanged: 1

Figure 2.4. Fetch Keys
S sudo apt—-get update

{base) sib:~/kishans sudo apt-get update

Ign http://dl.google.com stable InRelease

Ign http:/farchive.ubuntu.com trusty InRelease

Ign http:/fextras.ubuntu.com trusty InRelease

Hit https://deb.nodesource.com trusty InRelease
Ign http:/farchive.canonical.com precise InRelease
Hit http://ppa.launchpad.net trusty InRelease

Figure 2.5. Update Ubuntu Packages Repositories

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.
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$ sudo apt-get install cuda-9-0

{base) sib:~/kishans sudo apt-get install cuda-9-8
Reading package lists... Done

Building dependency tree

Reading state information... Done

Figure 2.6. CUDA Installation Completed

2.2.2. Installing the cuDNN
To install the cuDNN:
1. Create Nvidia developer account in https://developer.nvidia.com.

2. Download cuDNN lib in https://developer.nvidia.com/compute/machine-
learning/cudnn/secure/v7.1.4/prod/9.0_20180516/cudnn-9.0-linux-x64-v7.1.

3. Execute the commands below to install cuDNN

S tar xvf cudnn-9.0-linux-x64-v7.1.tgz

S sudo cp cuda/include/cudnn.h /usr/local/cuda/include

S sudo cp cuda/lib64/libcudnn* /usr/local/cuda/lib64

S sudo chmod a+r /usr/local/cuda/include/cudnn.h /usr/local/cuda/lib64/libcudnn*

ks tar xvf cudnn-9.0-linux-x64-vr.1.tgz

cuda/inc lude/cudnn. h

cuda/MIDTA SLA cuDNN_Support. txt

cuda/Tibed/1ibcudnn. so0

cuda/libed/libcudnn. s0.7

cuda/libed/libcudnn. s0.7.1.4
cuda/libsd/Tibcudnn_static.a

k5 sudo cp cuda/include/cudnn.h fusr/local/cuda/include
k5 sudo cp cuda/libed/Tibcudnn®* fusr/local/cuda/Tibe4d
k5 sudo chmod a+r fusr/local/cuda/includes/cudnn.h fusr/local fcuda/Tibed/ Tibcudnn®
kS _

Figure 2.7. cuDNN Library Installation

2.2.3. Installing the Anaconda and Python 3
To install the Anaconda and Python 3:
1. Go to https://www.anaconda.com/distribution/#download-section.

2. Download Python 3 version of Anaconda for Linux.

sib:~/kishan$ wget https://repo.anaconda.com/archive/Anaconda3-2019.03-L1nux-x86_64.sh

--2019-04-18 11:34:54-- https://repo.anaconda.com/archive/Anaconda3-2019.03-Linux-x86_64.sh

Resolving repo.anaconda.com (repo.anaconda.com)... 104.16.131.3, 104.16.130.3, 2606:4760::6810:8303, ...
Connecting to repo.anaconda.com (repo.anaconda.com)|104.16.131.3/:443... connected.

HTTP request sent, awaiting response... 200 0K

Length: 685906562 (654M) [application/x-sh]

Saving to: ‘Anaconda3-2619.03-Linux-x86_64.sh’

160%[

Figure 2.8. Anaconda Package Download

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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3. Install the Anaconda environment by running the command below:

$ sh Anaconda3-2019.03-Linux-x86_64.sh
Note: Anaconda3-<version>-Linux-x86_64.sh, version may vary based on the release

sib:~/kishand sh Anaconda3-2019.03-l inux-x86_64.sh

Helcome to Anaconda3 2019.83

In order to continue the installation process, please review the license

agreement.
FPlease, press ENTER to continue
b

Figure 2.9. Anaconda Installation

4. Accept the license.

Do you accept the license terms? [yves/no]
fno] === yes

Figure 2.10. Accept License Terms

5. Confirm the installation path. Follow the instruction on screen if you want to change the default path.

Do you accept the license terms? [yes|no]
fna] === yes

Anaconda3 will now be installed into this location:
Shome/sibridge/anaconda3

- Press ENTER to confirm the location
- Press CTRL-C to abort the installation
- Or specify a different location below

[/home/sibridge/anaconda3] >=> /Jhome/sibridge/kishan/anaconda3_

Figure 2.11. Confirm/Edit Installation Location

6. Afterinstallation, enter No as shown in Figure 2.12.

installation finished.
Do yvou wish the installer to initialize Anaconda3

by running conda init? [yes/na]
fnoj === no_

Figure 2.12. Launch/Initialize Anaconda Environment on Installation Completion

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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2.2.4. Installing the TensorFlow v1.12 (or higher)
Note: TensorFlow2.0 is not supported.
To install the TensorFlow v1.12:

1. Activate the conda environment by running the command below:

S source <conda directory>/bin/activate

sib:~/kishand source anaconda3/binfactivate
{base) sib:~/kishans _

Figure 2.13. Anaconda Environment Activation

2. Install the TensorFlow by running the command example below:

$ conda install tensorflow-gpu==1.12.0

(base) sib:~/kishans conda install tensorflow-gpu==1.12.0

HARNING: The conda.compat module is deprecated and will be removed in a future release.
Collecting package metadata: done

Solving environment: done

% Package Plan ##
environment location: Shome/sibridge/kishan/anaconda3

added / updated specs:
- tensorflow-gpu==1.12.0

Figure 2.14. TensorFlow Installation

3. Afterinstallation, enter Y as shown in Figure 2.15.

wurlitzer 1.8,.2-py37 @ --> 1.0,.2-py36 0
xlrd 1.2.0-py37 @ --> 1,.2.0-py36 0
xlwt 1.3.0-py37 @ --> 1.3.0-py36 @
zict @.1.4-py37 @ --> @.1.4-py36 @
Zipp @.3.3-py37 1 --> 0.3.3-py36 1

Proceed ([v]/n}? yv_

Figure 2.15. TensorFlow Installation Confirmation
Figure 2.16 shows that the TensorFlow installation is complete.

Preparing transaction: done
Verifying transaction: done
Executing transaction: done
{(base) sib:~/kishans _

Figure 2.16. TensorFlow Installation Completion

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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2.2.5. Installing the Python Package

To install the Python package:
1. Install Easydict by running the command below:

S conda install —c conda-forge easydict

{(base) sib:~/kishans conda install -¢ conda-forge easydict

Collecting package metadata: done
Solving environment: done

i Package Plan ##

environment location: fhome/sibridge/kishan/anaconda3

added / updated specs:
- easydict

Figure 2.17. Easydict Installation

2. Install Joblib by running the command below:
$ conda install joblib

(base) sib:~/kishans conda install joblib
Collecting package metadata: done
Solving environment: done

## Package Plan ##

environment location: Shome/sibridges/kishan/anaconda3

added / updated specs:
- joblib

Figure 2.18. Joblib Installation

3. Install Keras by running the command below:
S conda install keras

{(base) sib:~/kishans conda install keras
Collecting package metadata: done
Solving environment: done

## Package Plan ##

environment location: Shome/sibridge/kishan/anaconda3

added / updated specs:
- keras

Figure 2.19. Keras Installation

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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4. Install OpenCV by running the command below:

S conda install opencv

(base) sib:~/kishans conda install opencv
Collecting package metadata: done
Solving environment: done

## Package Plan ##

environment location: Shome/sibridge/kishan/anaconda3

added / updated specs:
- apencv

Figure 2.20. OpenCV Installation

5. Install Pillow by running the command below:

$ conda install pillow

(base) sib:~/kishans conda install pillow
Collecting package metadata: done
Solving environment: done

# All requested packages already installed.

(base) sib:~/kishans _

Figure 2.21. Pillow Installation

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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3. Preparing the Dataset

This section describes how to create a dataset using Google Open Image Dataset as an example.

The Google Open Image Dataset version 4 (https://storage.googleapis.com/openimages/web/index.html) features
more than 600 classes of images. The Person class of images includes human annotated and machine annotated labels
and bounding box. Annotations are licensed by Google Inc. under CC BY 4.0 and images are licensed under CC BY 2.0.

3.1. Downloading the Dataset

To download the dataset, run the commands below:

1. Clone the OIDv4_Toolkit repository:

$ git clone https://github.com/EscVM/OIDv4 ToolKit.git
$ cd OIDv4 ToolKit

{(base) kS git clone https://github.com/EscVWM/0IDvd_ToolKit.git
Clening into '0IDv4_ToolKit'...

remote: Enumerating objects: 25, done.

remote: Counting objects: 108% (25/25), done.

remote: Compressing objects: 100% (24/24), done.

remate: Total 382 (delta 3), reused 14 (delta 1), pack-reused 357
Receiving objects: 100% (382/382), 34.06 MiB | 752.00 KiB/s, done.
Resolving deltas: 100% (111/111), done.

(base) ks

Figure 3.1. Open Source Dataset Repository Cloning
Figure 3.2 shows the OIDv4 code directory structure.

0IDv4_ToolKit/

— classes. txt

— images
classes.png
rectangle.png
visualizer_example.gif

— LICENSE

— main.py

— modules

— bounding_boxes.py

— csv_downloader.py

— downloader.py

— image_level.py

— parser.py

— show.py

— test.py

— utils.py

— README. md

— regquirements. txt

Figure 3.2. OIDv4_Toolkit Directory Structure

View the OIDv4 Toolkit Help menu:

$ python3 main.py -h

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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(base) k5 python3 main.py -h

usage: main.py [-h] [--Dataset /path/to/0ID/csv/]
[--classes list af classes [list of classes ...J]
[--type _csv 'train' or 'wvalidation' or 'test' or 'all']
[--sub Subset of human verified images or machine generated h or m)]
[--image_IsOccluded 1 or @] [--image IsTruncated 1 or @]
[--image IsGroupdf 1 or @] [--image IsDepiction 1 or @]
[--image_IsInside 1 or @] [--multiclasses @ (default or 1]
[--n_threads [default 28]] [--nolabels]
[--limit integer number]
<command> 'downloader', 'visuwalizer' or 'ill_downloader'.

Open Image Dataset Downloader

pasitional arguments:
<command> 'downloader', 'visualizer' or 'ill_downloader'.
'downloader', 'viswalizer' or 'il1_downloader'.

Figure 3.3. Dataset Script Option/Help

2. Use the OIDv4 Toolkit to download dataset. Download the Person class images:

$ python3 main.py downloader --classes Person --type csv validation

(base) k$ python3 main.py downloader --classes Person --type_csv validation --limit 200

Figure 3.4. Dataset Downloading Logs
Figure 3.5 shows the downloaded dataset directory structure.

— OID
csv_folder
t:: class-descriptions-boxable.csv
validation-annotations-bbox.csv
Dataset
L— validation
L— Person
ff7bdcc8casbe592. jpg
Label
L— ff7bdcc8casbes9z2. txt

Figure 3.5. Downloaded Dataset Directory Structure

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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3. Lattice training code uses KITTI (.txt) format. However, the downloaded dataset is not in exact KITTI format. Convert

the annotation to KITTI format.

$ sed -1 -- 's/Person/Person 0 0 0/g' OID/Dataset/validation/Person/Label/*
$ sed -1 -- 's/Person/Person 0 0 0/g' OID/Dataset/train/Person/Label/*
$ sed -1 —-- 's/Person/Person 0 0 0/g' OID/Dataset/test/Person/Label/*

{(base) k5 cat 0ID/Dataset/validation/Person/lLabel/ff7bdcc8ca?bss92. txt

Person 324.614144 £9.2%05733 514. 5659472 681.5072

{(base) k5 sed -i -- 's/Person/Person @ @ 8/g' 0ID/Dataset/validation/Person/Label/ *
{(base) k5 cat 0ID/Dataset/validation/Person/lLabel/ff7bdcc8ca?bss92. txt

Person @ @ @ 324.6014144 69.905733 814. 565472 681.5072

{(base) k5

Figure 3.6. OIDv4 Label to KITTI Format Conversion

Note:

KITTI Format: Person 0 0 0 324.61 69.90 814.56 681.90

It has class ID followed by truncated, occluded, alpha, Xmin, Ymin, Xmax, Ymax.

Code converts Xmin, Ymin, Xmax, Ymax into x, y, w, h while training as bounding box rectangle coordinates.

3.2. Visualizing and Tuning/Cleaning Up the Dataset
To visualize and annotate the dataset, run the command below:
1. Visualize the labeled images.

$ python3 main.py visualizer

(base) k$ python main.py visualizer

Rt o WA St 2 = Visualizer: 0/29/02e286eeb83a3608.jpg

R SR ET {1
/ Vilak ™ £ Ve sl fecflifs
(AR I I GO R O S A
| B [ S Y Al A WV 4 ==
RO R e S e /
{1 ) (M ED)

L1 e s o ssasdf, f SEIA
W70 A o [ € Yz
Vsl = GO Bllia=Coto4] ]
/Gl A oS G ) i)

Which folder do you want to visualize (train, test, validation)? <exit>
> /tmp/images
Which class? <exit>

- Person
> Person
(x=251.v=161~R:181 G138 B:83

INFO

- Press 'd' to select next image

- Press 'a’ to select previous image

- Press 'e' to select a new class

- Press 'w' to select a new folder

- Press 'q' to exit

Figure 3.7. Toolkit Visualizer
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2. Clone the manual annotation tool from the GitHub repository.

$ git clone https://github.com/SaiPrajwal95/annotate-to-KITTI.git

(base) ks git clone https://github.com/SaiPrajwal 95 /annotate-to-KITTI.git
Cloning into 'annotate-to-KITTI'...

remate: Enumerating objects: 27, done.

remote: Total 27 (delta @), reused @ (delta @), pack-reused 27

Unpacking objects: 100% (27/27), done.

(base) kS _

Figure 3.8. Manual Annotation Tool — Cloning

3. Goto annotate to KITTI.

$ cd annotate-to-KITTI
S 1s

annotate-to-KITTI/

|: annotate-folder.py
README . md

Figure 3.9. Manual Annotation Tool — Directory Structure

4. Install the dependencies (OpenCV 2.4).

$ sudo apt-get install python-opencv
5. Launch the utility.

$ python3 annotate-folder.py
6. Set the dataset path and default object label.

{base) k5 python3 annotate-folder.py

Enter the path to dataset: /tmp/images

Enter default object label: Person

f{'label': 'Person’, 'bbox': {'xmin': 443, 'vmin': 48, ‘'xmax': 811, 'ymax': 683}}]
{base) k5 _

Figure 3.10. Manual Annotation Tool — Launch

7. For annotation, run the script provided in the website below.
https://github.com/SaiPrajwal95/annotate-to-KITTI

For information on other labeling tools, see Table A.1.
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3.3. Data Augmentation

Data Augmentation needs a large amount of training data to achieve good performance. Image Augmentation creates
training images through different ways of processing or combination of multiple processing such as random rotation,
shifts, shear and flips, and others.

4 @] augmentation
4 fm] data_aug
[0 _init_.py
[0 bbox_util.py

[1 data_aug.py
[l augmentation.py
1 config.py
B README.md

Figure 3.11. Augmentation Directory Stucture

e data_aug — It contains basic methods and augmentation classes.
e augmentation.py — This file reads the input images (input labels) and performs preferred augmentation on it.
e config.py — Contains parameters that are used in augmentation operations.

3.3.1. Configuring the Augmentation
To configure the augmentation:

1. Configure the config.py file which contains the parameters shown in Figure 3.12.

Figure 3.12. config.py Configuration File Parameters

Choose the operations to perform on the dataset. The operations can be selected in augmentation.py by editing
the list all_op.
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Figure 3.13. Selecting the Augmentation Operations

2. Add or Remove the operation by commenting/uncommenting the operation in the all_op list as shown in Figure
3.13.

3.3.2. Running the Augmentation
Run the augmentation by running the following command:

python augmentation.py --image dir <Path To InputlImage Dir> --label dir
<Path To InputLabel Dir> --out image dir <Path To OutputImage Dir> --out label dir
<Path To OutputLable Dir>

earth:~$ python augmentation.py --image_dir /data/images/ --label_dir /data/labels/ --out_image_dir /tmp/labels --out_label_dir /tmp/images/

nBrightn
G anFiltering

Figure 3.14. Running the Augmentataion
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4. Training the Machine

4.1. Training Code Structure

~ ECP5 HUMANCNT TRAINING
~ data’ humancnt
dataset_create.py
? logs ' humancnt ', train
> scripts
7 SIC
config
dataset
nets
utils
binary_ops.py
eval.py

genpb.py

inference.py

nn_skeleton.py

train.py
run
run_genarate_frozen_file

rurn_inference

Figure 4.1. Training Code Directory Structure
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4.2. Neural Network Architecture

4.2.1. Human Count Training Network Layers

This section provides information on the Convolution Network Configuration of the Human Presence Detection design.
The Neural Network model of the Human Presence Detection design uses MobileNet Neural Network base model and
the detection layer of SqueezeDet model.

Table 4.1. Human Counting Training Network Topology
Image Input (224 x 224 x 3)

Fire O Conv3-32 Conv3 - # where:
BN e  Conv3 =3 x 3 Convolution filter Kernel size

RelLU e  #=The number of filters
For example, Conv3 - 32 = 32 x 3 x 3 convolution filters

MaxPool

ResBlk_1 Conv3-32
BN

RelLU

BN — Batch Normalization
ReLU — Rectified Linear Unit (Activation function)
MaxPool — Max Pooling
Conv3 -32 Eltwise — Eltwise add operation
BN

Eltwise
(Fire0-Maxpool + ResBlk_2-BN)

RelLU
MaxPool
Fire 1 Conv3-64

BN

RelLU
MaxPool
ResBlk_2 Conv3-64

BN

RelLU

Conv3-64
BN

Eltwise
(Firel-Maxpool + ResBlk_5-BN)

RelLU
MaxPool
Conv12 Conv3 —42

e Human Count Network structure consists of two fire layers and t residual blocks. A fire layer contains convolution,
batch normalization, RelLU layer, and pooling layer. A residual block contains convolution, batch normalization, and
ReLU layers with pooling layer.

e All the convolution layers in fire layers and residual blocks have stride 1.

e Avresidual block has a skip connection functionality so that the input to the first convolution layer connects to the
input of the last ReLU layer using add operation inside all the residual blocks.

e InTable 4.1, the layer contains convolution (conv), batch normalization (bn), and ReLU layers.

e Layer information:

e Convolutional Layer
In general, the first layer in a CNN is always a convolutional layer. Each layer consists of number of filters
(sometimes referred as kernels), which convolves with the input layer/image and generates an activation map
(that is. feature map). This filter is an array of numbers (called weights or parameters). Each of these filters can
be thought of as feature identifiers, such as straight edges, simple colors, curves, and other high-level features.
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For example, the filters on the first layer convolve around the input image and activate (or compute high
values) when the specific feature it is looking for (such as curve, for example) is in the input volume.

e  RelU (Activation Layer)
After each conv layer, it is convention to apply a nonlinear layer (or activation layer) immediately afterward.
The purpose of this layer is to introduce nonlinearity to a system that basically has just been computing linear
operations during the conv layers (element wise multiplications and summations). In the past, nonlinear
functions such as tanh and sigmoid were used, but researchers found out that ReLU layers work far better
because the network is able to train a lot faster (because of the computational efficiency) without making a
significant difference in accuracy. The ReLU layer applies the function f(x) = max (0, x) to all of the values in the
input volume. In basic terms, this layer changes all the negative activations to 0. This layer increases the
nonlinear properties of the model and the overall network without affecting the receptive fields of the conv
layer.

e Pooling Layer
After some RelU layers, you may choose to apply a pooling layer. It is also referred to as a down sampling layer.
In this category, there are also several layer options, with Maxpooling being the most popular. This basically
takes a filter (normally of size 2 x 2) and a stride of the same length. It then applies it to the input volume and
outputs the maximum number in every sub region that the filter convolves around.
The intuitive reasoning behind this layer is that once it is known that a specific feature is in the original input
volume (there is a high activation value), its exact location is not as important as its relative location to the
other features. As you can imagine, this layer drastically reduces the spatial dimension (the length and the
width change but not the depth) of the input volume. This serves two main purposes. The first is that the
number of parameters or weights is reduced by 75%, thus lessening the computation cost. The second is that it
controls over fitting. This term is used when a model is so tuned to the training examples that it is not able to
generalize well for the validation and test sets. A symptom of over fitting is having a model that gets 100% or
99% on the training set, but only 50% on the test data.

e  Batch Normalization Layer
Batch normalization layer reduces the internal covariance shift. To train a neural network, some preprocessing
to the input data are performed. For example, you can normalize all data so that it resembles a normal
distribution (that means, zero mean and a unitary variance). This prevents the early saturation of non-linear
activation functions such as sigmoid and assures that all input data are in the same range of values, and others.
An issue, however, appears in the intermediate layers because the distribution of the activations is constantly
changing during training. This slows down the training process because each layer must learn to adapt them to
a new distribution in every training step. This is known as internal covariate shift.
Batch normalization layer forces the input of every layer to have approximately the same distribution in every
training step by following the process below during training time:
a. Calculate the mean and variance of the layers input.
b. Normalize the layer inputs using the previously calculated batch statistics.

c. Scale and shift to obtain the output of the layer.
This makes the learning of layers in the network more independent of each other and allows you to be care-
free about weight initialization, works as regularization in place of dropout, and other regularization
techniques.
The architecture above provides nonlinearities and preservation of dimension that help to improve the robustness of
the network and control over fitting.
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4.2.2. Human Count Detection Network Output

From the input image model, it extracts the feature maps first and overlays them with a W x H grid. And then, each cell
computes K pre-computed bounding boxes called anchors. Each bounding box has the following:

Four scalars (x, y, w, h)
e A confidence score (Pr(Object)*I0U)
e  C° conditional class probability
The current model architecture has a fixed output of WxHxK(4+1+C). where:
e W, H=Grid Size
e K= Number of Anchor boxes
e C = Number of classes for which you want detection
The model has a total of 8232 output values which are derived from the following:
e 14x14grid
e Seven anchor boxes per grid
e Six values per anchor box. It consists of:

e  Four bounding box coordinates (x, y, w, h)

e One class probability

e  One confidence score

Soin total, 14 x 14 x 7 x 6 = 8232 output values.

4.2.3. Training Code Overview

" Model building
Pacanocrs |
CNN
architecture

Loss
funclions

.\.- -./.

,"-—-'\
[ Freeze model and |
generate .pb file

Generate pb
from _pbixt and

‘ Train model |

Y

‘J Exit |47

Figure 4.2. Training Code Flow Diagram
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Training Code is divided into the following parts:
e Model Configuration

e Model Building

e  Model Freezing

e Data Preparation

e Training for Overall Execution Flow

Details of each can be found in subsequent sections.

4.2.3.1. Model Configuration
The design uses Kitti dataset and SqueezeDet model. kitti_squeezeDet_config() maintains all the configurable parameters
for the model. Below is the summary of configurable parameters:
e Image size
e Change mc.IMAGE_WIDTH and mc.IMAGE_HEIGHT to configure Image size (width and height) in
src/config/kitti_squeezeDet_config.py.

mc . IMAGE_WIDTH

mc . IMAGE _HEIGHT

Figure 4.3. Code Snippet — Input Image Size Config

e Since there are four pooling layers, grid dimension is H = 14 and W = 14. anchor_shapes variable of
set_anchors() in src¢/config/kitti_squeezeDet_config.py indicates anchors width and heights. Update it based on
anchors per gird size changes.

H, W, B = 14, 14, 7

div_scale = 2.8

Figure 4.4. Code Snippet — Anchors Per Grid Config #1 (Grid Sizes)

e Batchsize
e Change mc.BATCH_SIZE in src/config/kitti_squeezeDet_config.py to configure batch size.
e Anchors per grid
e Change mc.ANCHOR_PER_GRID in src/config/kitti_squeezeDet_config.py to configure anchors per grid.

mc . ANCHOR_BOX set_anchors(mc)
mc . ANCHORS len({mc . ANCHOR _BOX)

mc . ANCHOR_PER_GRID 7

Figure 4.5. Code Snippet — Anchors Per Grid Config #2

e Change hard coded anchors per grid in set_anchors() in src/config/kitti_squeezeDet_config.py. Here, B (value
7) indicates anchors per grid.

e To run network on your own dataset, adjust the anchor sizes. Anchors are kind of prior distribution over what
shapes your boxes should have. The better this fits to the true distribution of boxes, the faster and easier your
training is going to be.

e To determine anchor shapes, first load all ground truth boxes and pictures, and if your images do not have all
the same size, normalize their height and width by the images’ height and width. All images are normalized
before being fed to the network, so you need to do the same to the bounding boxes and consequently, the
anchors.

e Second, perform a clustering on these normalized boxes (that is, you can use k-means without feature
whitening and determine the number of clusters either by eyeballing or by using the elbow method.)
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Check for boxes that extend beyond the image or have a zero to negative width or height.

anchor_shapes = np.reshape(
[np.array(

fdiv_scale)}],
_ fdiv_scale)]
r scale), int(1 fdiv_scale)]
_scale), ‘'div_scale)],
fdiv_scale), fdiv_scale)
./div_scale), i ./div_scale]
iv_scale)]]1)] * H * W,

Ll
Ll

Figure 4.6. Code Snippet — Anchors Per Grid Config #3

Training Parameters

Other training related parameters such as learning rate, loss parameters, and different thresholds can be
configured from src/config/kitti_squeezeDet_config.py.

.WEIGHT DECAY 0.0001
.LEARNING RATE 0.81
.DECAY_STEPS 10000
.MAX_GRAD_NORM

.MOMENTUM

.LR_DECAY FACTOR

.LO55 COEF_BBOX

.LOSS COEF_CONF_POS

.LO55 COEF_CONF_NEG
c.L0S55 COEF_CLASS

.PLOT_PROB_THRESH

.NMS_THRESH

.PROB_THRESH
c.TOP_N_DETECTION

.DATA AUGMENTATION

.DRIFT X

.DRIFT_Y
.EXCLUDE_HARD EXAMPLES

Figure 4.7. Code Snippet — Training Parameters
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4.2.3.2. Model Building

SqueezeDet class constructor builds model, which is divided into the following sections:
e Forward Graph

e Interpretation Graph

e Loss Graph

e Train Graph

e Visualization Graph

Forward Graph
e The CNN architecture consists of Convolution, Batch Normalization, ReLU, and Maxpool.
e  Forward Graph consists of two fire layers and four residual blocks as described in Table 4.1.

f1 w bin
f1 a bin

ml w bin
ml a bin
s1 w_bin

min_rng
max_rng

Figure 4.8. Code Snippet — Quantization Setting

e  Filter sizes of each convolutional blocks are mentioned in Table 4.1, which can be configured by changing the
values of depth, as shown in Figure 4.9.

depth [ 32, 32, 32, 64, 64, 64]

fired = sel fire layer('fire@', self.image input,oc=depth[0], freeze=False, w bin=fl w bin, a b
ResBlk 2 = self. ResNetBlock( lk 2', ResBlk 1, depthl=depth[1], depth2=depth[2], freeze=Fa
firel = self. fire layer('firel', ResBlk 2,oc=depth[3], freeze=False, w bin=fl w bin, a bin=fl a
ResBlk 5 = self. ResNetBlock('ResBlk 5', ResBlk 4, depthl=depth[4], depth2=depth[5], freeze=

fire 0 = ResBlk 5

Figure 4.9. Code Snippet — Forward Graph Fire Layers and Residual Blocks with Filters

num_output = mc.ANCHOR PER_GRID * (mc.CLASSES + 1 + 4)

.preds = ._conv_layer('convl2', fire o, filters=num output, size=3

stride=1,

padding="SAME’, xavier= » relu= » stddev=8.8881, w bin=s1 w bin)
(self.preds:’ .preds)

Figure 4.10. Code Snippet — Forward Graph Last Convolution Layer
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Interpretation Graph
e The Interpretation Graph consists of the following sub-blocks:
e interpret_output

This block interprets output from network and extracts predicted class probability, predicated confidence
scores, and bounding box values.
Output of the convnet is a 14 x 14 x 42 tensor — there are 42 channels of data for each of the cells in the grid
that is overlaid on the image and contains the bounding boxes and class predictions. This means the 42
channels are not stored consecutively but are scattered all over the place and need to be sorted. Figure 4.11
and Figure 4.12 explain the details.

14

14

Figure 4.11. Grid Output Visualization #1

For each grid, cell values are aligned as shown in Figure 4.12.

42 walues = (anchor 1,anchor 2, anchar 3.anchor 4,ancor 5.anchar 6,anchar 7)

—_’f 42 valuss = (7 X § a5 23ch anchor as & values)

14

14

Figure 4.12. Grid Output Visualization #2
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Figure 4.13 shows the output from conv12 layer (4D array of batch size x 14 x 14 x 42) needs to be sliced with
proper index to get all values of probability, confidence, and coordinates.

num_confidence_scores = mc.ANCHOR_PER_GRID
.pred_conf = tf.sigmoid(
tf.reshape(
preds[:, :, :, :num_confidence_scores],
[mc.BATCH_SIZE, mc.ANCHORS]
) s

name="pred confidence_

num_class_probs = mc.ANCHOR_PER_GRID*mc.CLASSES+num_confidence_scores

.pred class probs = tf.reshape(
tf.nn.softmax(
tf.reshape(
preds[:, :, :, num_confidence scores:num_class_probs],
[-1, mc.CLASSES]
)
) s

[mc.BATCH_SIZE, mc.ANCHORS, mc.CLASSES],
name="pred_cl '

.pred_box_delta = tf.reshape(
preds[:, :, :, num_class probs:],
[mc.BATCH SIZE, mc.ANCHORS, 4],
name="bbox delta®

Figure 4.13. Code Snippet — Interpret Output Graph

For confidence score, this must be a number between 0 and 1, so sigmoid is used.
For predicting the class probabilities, there is a vector of NUM_CLASS values at each bounding box. Apply a
softmax to make it probability distribution.

e  bbox
This block calculates bounding boxes based on anchor box and predicated bounding boxes.

e |OU
This block calculates Intersection over Union for detected bounding boxes and actual bounding boxes.

e Probability
This block calculates detection probability and object class.

Loss Graph

This block calculates different types of losses, which need to be minimized. To learn detection, localization, and
classification, model defines a multi-task loss function. There are three types of losses which are considered for
calculation:
e Bounding Box

This loss is regression of the scalars for the anchors.
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tf.variable scope('bounding b
.bbox_loss = tf.truediv(
tf.reduce sum(
mc.L0SS COEF _BBOX * tf.square(
Linput_mask™®( .pred_box delta- .box_delta input))},

.num_objects,

.bbox_ loss)

Figure 4.14. Code Snippet — Bbox Loss

e Confidence Score

e To obtain meaningful confidence score, each box’s predicted value is regressed against the real and
predicted box. During training, compare the ground truth bounding boxes with all anchors and assign
them to the anchors that have the largest overlap (I0U).

e Select the closest anchor to match the ground truth box such that the transformation needed is reduced
to minimum. Equation evaluates to 1 if the k-th anchor at position-(i, j) has the largest overlap with a
ground truth box, and to 0 if no ground truth is assigned to it. This way, you only include the loss
generated by the responsible anchors.

e Asthere can be multiple objects per image, normalize the loss by dividing it by the number of objects
(self.num_objects).

tf.variable scope( confidence s e regression’) scope:
input mask = tf.reshape( .input _mask, [mc.BATCH SIZE, mc.ANCHORS])
.conf_loss = tf.reduce mean(
tf.reduce sum(
tf.square(( .dious - .pred_conf))

* {(input mask*mc.L0SS COEF_CONF_POS/ .num_cobjects
+(1-input_mask)*mc.L0OSS_COEF_CONF_MNEG/ (mc . ANCHORS- .num_objects)),
reduction indices=[1]

)
A

name="confidence loss

Figure 4.15. Code Snippet — Confidence Loss

e C(Class

e The last part of the loss function is cross-entropy loss for each box to do classification, as you would for
image classification.
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tf.variable scope('class

.class loss = tf.truediv(
tf.reduce sum(

i

{ .labels*(-tf.log( .pred class probs+mc.EPSILON))

+ (1- .labels)*(-tf.log(1- .pred class probs+mc.EPSILON)))
.input mask * mc.LOSS COEF_CLASS),
.num_objects,
name="class loss’

tf.add_to collection('losses”, .class loss)

Figure 4.16. Code Snippet — Class Loss

In one model architecture, you obtain the bounding box prediction, the classification, as well as the confidence score.

Train Graph
e This block is responsible for training the model with momentum optimizer to reduce all losses.

Visualization Graph
e This block provides visitations of detected results.

4.2.3.3. Training

mc.NUM_THREAD > @:

_ s loss value, conf loss, bbox loss, class loss = sess.run(
[model.train_op, model.loss, model.conf loss, model.bbox loss,
model_class loss], options=run_options)

feed _dict, , , _, _ = _load data(load_to_placeholder=

_» loss value, conf_loss, bbox loss, class loss = s
[model.train_op, model.loss, model.conf loss, model.bbox_ loss,
model.class loss], feed dict=feed dict)

Figure 4.17. Code Snippet — Training

sess.run feeds the data, labels batches to network, and optimizes the weights and biases. The code above handles the
input data method in case of multiple threads preparing batches, or data preparation in the main thread.
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4.3. Training from Scratch and/or Transfer Learning

To train the machine:

1. Go to the top/root directory of the Lattice training code from command prompt.
The model works on 224 x 224 images.

Current human count training code uses mean = 0 and scale = 1/128 (0.0078125) in pre-processing step. Mean and
scale can be changed in training code @src/dataset/imdb.py as shown in Figure 4.18.

= np.where(v <= 255 - add v, v + ad
final_hsv = cv2.merge((h, s, v))
.cvtColor(final hsv, cv2.COLOR_HSV2BGR)

im -= mc.BGR_MEANS
im /= 128.90
orig h, orig w, _ = [float(v) for v im.shape]

Figure 4.18. Training Code Snippet for Mean and Scale

The dataset path can be set in the training code @src/dataset/kitti.py and can be used in combination with the --
data_path option while triggering training using train.py to get the desired path. For example, you can have
<data_path>/training/images and <data_path>/training/labels.

imdb.

_PﬂDt_pﬁth,
_PﬂDt_pﬁth,

Figure 4.19. Training Code Snippet for Dataset Path

2. Create a train.txt.

$ cd data/humancnt/
$ python dataset create.py

Figure 4.20. Create File for Dataset train.txt

Notes:
e train.txt — file name of dataset images
e image_set —train (ImageSets/train.txt)
e data_path — SROOT/data/humandet/
e Images — SROOT/data/humandet/images
e Annotations — SROOT/data/humandet/labels
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3. Modify the training script.

@scripts/train.sh is used to trigger training. Figure 4.21 shows the input parameters, which can be configured.

ETRAINED MODEL PATH

Figure 4.21. Training Input Parameter

e  STRAIN_DATA_DIR — dataset directory path. /data/humandet is an example.

e STRAIN_DIR - log directory where checkpoint files are generated while model is training.
e SGPUID —gpu id. If the system has more than one gpu, it indicates the one to use.

e --summary_step — indicates at which interval loss summary should be dumped.

e --checkpoint_step —indicates at which interval checkpoints are created.

e --max_steps —indicates the maximum number of steps for which the model is trained.

4. Execute the run command script which starts training.

vice:GPU:0)

humancnt/train
minor: 5 me

: 10.34GiB
gpu devices: 0
library libcubl 0.10.0 locally

I e N

(L L I TR T T TR TR T}

g"D"J"D'D'D'D'D"D"D'D
F N >

Figure 4.22. Execute Run Script

5. Start TensorBoard.
$ tensorboard -logdir=<log directory of training>
For example: tensorboard —logdir="./logs/humancnt/train/’

6. Open the local host port on your web browser.

CTRL+C to quit)

Figure 4.23. TensorBoard — Generated Link
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7. Check the training status on TensorBoard.

TensorBoard SCALARS IMAGES GRAPHS DISTRIBUTIONS HISTOGRAMS  PROJECTOR INACTIVE - Q @
[] show data download links Q, Filter tags (regular expressions supported)
Ignore outliers in chart scaling
I0U_1 4
Tooltip sorting default  ~
' activation_summary/activation_summary activation_summary/activation_summary
Jconf_score/average feonf_score/max
. tag: I0U_1/activation_summary/activation_summary tag: I0U_1/activation_summary/activation_summary
Smoothing Jconf_score/ average Jeonf_score/max
—®— 06 I
0.940
1.050e-3
0.920
. " 9.500e-4
Horizontal Axis 0.900
6.500e-4
TEP RELATIVE WALL 0.580
7.500e-4 0.860
6.500e-4
Runs | I | | n-B40
8 -10.00k  -2.000k  6.000k 0.000 4.000k B.000k 12.00k
Write a regex to filter runs R I
DEH e — |
0.
activation_summary/activation_summary activation_summary/activation_summary
Jeonf_score/min Jeonf_score/sparsity
tag: I0U_1/activation_summary/activation_summary tag: I0U_1/activation_summary/activation_summary
fconf_score/min feonf_score/ sparsity

__________ o1 [ I 0-999| l_ Ll T

Figure 4.24. TensorBoard

Figure 4.25 shows the image menu of TensorBoard.

TensorBoard SCALARS  IMAGES  GRAPHS DISTRIBUTIONS  HISTOGRAMS  PROJECTOR INACTIVE

sample_detection_results
[C] Show actual image size P

Brightness adjustment PREVIOUS PAGE NEXT PAGE
sample_detection_results/image/0 ] sample_detection_results/image/1 [ |
————@ —————  RESET Step 10,300 step 10,300
Thu Aug 29 2019 10:32:08 GMT+0530 (India Standard Time) Thu Aug 29 2019 10:32:08 GMT+0530 (India Standard Time)
°® ®
Contrast adjustment

—@ —————————  RESET

Runs
Write a regex to filter runs
0.
sample_detection_results/image/2 ] sample_detection_results/image/3 [ ]
TOGGLEALL RUNS $9.19.390 step 10,300
Thu Aug 29 2019 10:32:08 GMT+0530 (India Standard Time) Thu Aug 29 2019 10:32:08 GMT+0530 (India Standard Time)
logs_1000/humancnt/train/ ® =3

T el —

Figure 4.25. Image Menu of TensorBoard

8. Check if the checkpoint, data, meta, index, and events (if using TensorBoard) files are created at the log directory.
These files are used for creating the frozen file (*.pb).
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nt_training ¥gs humancnt train

point

model.c 9.data-0

. maodel.ck 9.index

. model.ck 9.meta

Figure 4.26. Example of Checkpoint Data Files at Log Folder
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5. Creating Frozen File

This section describes the procedure for freezing the model, which is aligned with the Lattice SensAl tool. Perform the
steps below to generate the frozen protobuf file:

5.1. Generating the Frozen .pb File
Generate .pb file from latest checkpoint using below command from the training code’s root directory.

$ python src/genpb.py -ckpt dir <log directory> --freeze
For example, python src/genpb.py —ckpt_dir logs/humancnt/train —freeze.

earth:S python src/genpb.py --ckpt_dir logs/humancnt/train/ --freeze

del.ckpt-249999
pbts nt direcory Path
hape shape [1, 224, 224, 3]

Figure 5.1. .pb File Generation from Checkpoint

Figure 5.2 shows the generated .pb file.

sount_training logs humancnt train

. checkpoint

. model.ckp
. model.ckp

. model.ckp

Figure 5.2. Frozen .pb File
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6. Creating Binary File with Lattice SensAl

This chapter describes how to generate binary file using the Lattice SensAl version 3.0 program.

E Lattice SensAl Software s X
File Pr

s View Debug Help

SEMICONDUCTOR
o}

. y

Neural Network
Compiler Software

Figure 6.1. SensAl Home Screen

To create the project in SensAl tool:
1. Click File > New.

2. Enter the following settings:
e  Project Name
e Framework — TensorFlow
e (Class—CNN
e Device - ECP5
e  MOBBILENET Mode - Disabled

3. Click Network File and select the network (.pb) file.
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Project Winc
Project humanchnt_resnet. Framework Ten=sorF low - Clazs CHH -
Directory femp oo Device ECFS - [T HMOBILEMET mode
Tk, Files ftmpshunancnt_resnet .pb
InageYideo/Audio Data
[« ] [~ Scan Data Laver
Output Files
hunancnt_resnet ,gml
humancht_resnet , lscnl e
humancht_resnet Join

Post Processingilptional?

Cancel

Figure 6.2. SensAl — Network File Selection

4. Click Image/Video/Audio Data and select the image input file.

Project hunancht_resnet Framework TensorF low b | Class CHH -
Tirectory ftnp soo Tevice ECPS b | ["MOBILEMET made
Tk Fillss Atnpdhunancnt_resnet el

fnpdhunan, jog g

Inage/Video /Audio Data

[« I [ Scan Data Layer

Output Files

humancnt _resnet ,yml

humancnt_resnet.. lscml Remove

humancnt_resnet oin

Fost Processing {Optional}
Cancel MEXT
Figure 6.3. SensAl — Image Data File Selection

5. Click NEXT.

6. Configure your project settings.
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Project Windows N[

Inplementation Mame:

Humber Of Conwolution Engines:

Enable Paired Convolution Engine:

Humber Of On-Chip Memory Blocks:

Data Section Base Address

Ingut Memory Rssignnent:

Output Memory Assignrent

O0Ff-Chip Memory Address:
[T Store Input

Mean Valus for Data Pre-Processine:

Scale Value for Data Pre-Processing:

Cancel

7. Click OK to create the project.
8. Double-click Analyze.

Inplo

2 Allowed Value: 1-8

W {Dual Core Mode! (v Collapse Lawer

115 Min: Mum of Cony Engins = 1

251655240

Memories used to store input data (Comma seperated values?

Hewories used to store output data (Comnma seperated values?

4] [" Do Mot Use

T Store Dutput

] Keep Defasult valuss to bypass preprocessing
[0,0072128 | Dperation:Input Data =(Irput Data - Mean? x Scale
Ok

Figure 6.4. SensAl — Project Settings

[ Lattice SensAl Software - O X
File Process View Tools Help
— 5
LHEGED cpirp
| Process ‘ Files | Impl J Impl0
Project: resnet_dlayer Impl0 Blobs | Data Format (Analyzed) | Stored Data Format(User Edit) ‘ Required Memory Bytes ‘ MAE_Simulati
Pooling2 5.10 5.10 262144
E3Analyze for USE Debugging Convelutiond 510 5.10 524288
Compile Scaled 5.10 5.10 524288
- Simulate{Optional) Pooling3 5.10 5.10 131072
EdFloating Point Model Convelution3 510 5.10 131072
EdFixed Point Model Scaled 510 5.10 131072
Einference Engine Model Convelutiond 510 310 131072
Post Processing Scale 5.10 5.10 131072
Download Eltwise? 5.10 5.10 131072
Run Poclingd 510 5.10 32768
ﬁ conv12/bias_ac 5.10 5.10 131072

Figure 6.5. SensAl — Analyze Project

9. Confirm the Q format of each layer as shown in Figure 6.6 and update if required.
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Blobs Data Format (Analyzed) | Stored Data Forrat(User Edit) | Required Memory Bytes
data 510 1.7 196608
Convolution 510 5.10 3670016
Scalel 510 510 3670016
Poolingl 510 5.10 1048576
Convolution2 510 510 1048576
Scale2 510 5.10 1048576
Convolution3 510 510 1048576
Scaled 510 5.10 1048576
Eltwisel 510 510 1048576
Pooling2 510 510 262144
Convolutiond 510 510 524238
Scaled 510 510 524288
Pooling3 510 5.10 131072
Convolutions 5.0 510 131072
Scaled 5.10 5.10 131072
Convolutiong 510 510 131072
Scaled 5.10 5.10 131072
Eltwisel2 510 510 131072
Poolingd 510 5.10 32768
convl2/bias_ac 510 510 131072

Figure 6.6. Q Format Settings for Each Layer

10. Double-click Compile to generate the firmware file.

File Processz WYiew Toolzs Help

LHEGE

Figure 6.7. Compile Project

F'rocess| Files | Impl I Impla
Project: humancnt_resnet Implo Blobs | Data Format (Analyzed)

[> Analyze data 5.10
[» Simulate{Optionaly Scalet 5.10
Post Processing Poalingt 3]
Download Convelution2 5.10
Run Scale2 510
Convelution3 5.10
Scaled 3]
Eltwise1 6.3
Convalutiond 510
Scale4 5.10
EETTTT| convoluons 10

42

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.

FPGA-RD-02195-1.0


http://www.latticesemi.com/legal

= LATTICE

7. Hardware Implementation

7.1. Top Level Information

7.1.1. Block Diagram

ECP5

DDR3
- L - e e
External DRAM “ontrol o+ AX| Slave i CNN Accelerator
h
External Micro
L T ”
SD Card SD loader > det_out_filter
224 x 224
h 4
CSI2_to_DVI_top
- External
External ‘s w| Crop_downscale_human_count B HDMI
Camera
L3 12C_top T
[ 3

HDMI__i2c_top

Figure 7.1. RTL Top Level Block Diagram

7.1.2. Operational Flow

This section provides a brief idea about the data flow across ECP5 board.

The CNN module is configured with the help of a binary (.bin) file stored in an SD card. The .bin file is a command
sequence code which is generated by the Lattice Machine Learning software tool.

The command code is written in the DRAM through AXI before the execution of the CNN Accelerator IP Core starts.
CNN reads the command code from the DRAM during its execution and performs calculation per command code.
Intermediate data may be transferred from/to DRAM per command code.

The external camera configured using the 12C_top logic block captures the raw image and passes it to the
CSI2_to_DVI_top module. The CSI2_to_DVI_top module separates the R, G, and B pixels from raw data and creates
separated colors to match the real world using gain and offset controls.

The RGB data from CSI2_to_DVI_top module is downscaled to 224 x 224 image resolution by
crop_downscale_human_count module to match CNN’s input resolution. This data is written into internal memory
block of CNN Accelerator IP Core through input data ports.

After the command code and input data are available, the CNN Accelerator IP Core starts the calculation at the
rising edge of start signal.

The output data of the CNN is passed to the det_out_filter for post processing. The det_out_filter generates
bounding box coordinates X, Y, W, H associated with the top 20 confidence value indexes for 224 x 224 image
resolution.

These coordinates are passed to the crop_downscale_human_count again for resizing to fit the actual image
resolution on HDMI display. HDMI is configured using the hdmi_i2c_top block.
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Constant Default Description
(Decimal)
CONF_THRESH 65472 Signed confidence threshold value calculated as per Q-Format of last layer of CNN
(that is -64) For example, if threshold is to be kept at -0.0625, then Q-Format is Q5.10,
CONF_THRESH.
=2’'s complement ((0.0625) * (2210))
=2’'s complement (64)
= 65472 Decimal = FFCO Hex
INF_MULT_FAC 19884 Inference time multiplying factor calculated as per CNN clock frequency and using
Q-Format (Q1.31)
CNN clock frequency = 108 MHz.
Hence, CNN clock period
=1/(108 x 10®) us
=0.000009259259 ms
Therefore, Q1.31 = 0.000009259259 x 23! ~ 19884 decimal.
OVLP_TH_2X Intersection Over Union threshold (NMS)
NUM_FRAC Fraction Part Width in Q-Format representation.
EN_INF_TIME Used to enable Timing Measurement logic. By default, value is zero and the
memory file used is human_count.mem.
If assigned to 1, timing measurement is enabled and the memory file used is
human_count_INF.mem.
In order to configure the respective memory file, follow the steps below:
e Open ecp.sbx from file list using clarity designer in Diamond user interface.
e  Go to Builder tab in Clarity designer.
e  Right-click on dpram8192x8_human_count and select config.
e Click on Browse Memory File from Initialization section
e  Update the following mem file path:
For 0 - /src/vip_common/humant_count.mem
For 1 - /src/vip_common/human_count_INF.mem
Constant Parameters (Not to be modified)
NUM_ANCHOR 1372 Number of reference bounding boxes for all grids
NUM_GRID 196 Total number of Grids (X * Y)
NUM_X_GRID 14 Number of X Grids
NUM_Y_GRID 14 Number of Y Grids
PIC_WIDTH 224 Picture Pixel Width (CNN Input)
PIC_HEIGHT 224 Picture Pixel Height (CNN Input)
NUM_CLASS 1 Number of probability classes
TOP_N_DET 20 Number of Top confidence bounding boxes detection
OBJECT BODY Detection of upper human body from input image

7.2. Architecture Details

7.2.1. Pre-processing CNN

The output from the CSI2_to_DVI_top module is a stream of RGB data that reflects the camera image, which is given to
crop_downscale_human_count module.

The crop_downscale_human_count module processes that image data and generates input of 224 x 224 image data
interface for CNN IP.
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7.2.1.1. Pre-processing Flow
e RGB data values for each pixel are fed serially line by line for an image frame.

e These RGB data values are considered as valid only when horizontal and vertical masks are inactive. Mask

parameters are set such that it masks out boundary area of full HD resolution (1920 x 1080) to 1792 x 896.

Left Zone (Active) Right Zone (Inactive)

1920

A
L 4

Figure 7.2. Masking and Zoning

The Frame of 1792 x 896 is further divided in half horizontally by making two blocks of 896 x 896 of the same
frame as shown in Figure 7.2. This is done to make the downscaling process easier.

When the left zone is active, pixel values from the left zone are used to generate CNN input image data. Pixel
values from right zone are ignored. After the data is sent to CNN, the active zone is changed to the right zone.
When CNN is ready to accept data, the pixel values from the right zone are used to generate the CNN input image
data.

Each 896 x 896 frame block is downscaled into 224 x 224 resolution image as shown in the Figure 7.3.

Accumulation into
/__) single Pixel

A
[
«
[
A\

Figure 7.3. Downscaling

A single accumulated pixel value is generated for each 4 x 4 grid of pixels. This leads to generate 224 x 224 values
(896/4 x 896/4) from 896 x 896 values.

The accumulated value is written into Frame Buffer. Frame Buffer is a True Dual-Port RAM. Accumulated R, G, and
B pixel values for 4 x 4 grids are stored in the same memory location.

When Data is read from memory each RGB value is divided by 16 (that is the area of 4 x 4 grid) to take the average
of 4 x 4 grid matrix.

Data from Memory is read and formatted for compatibility with the trained network according to CNN input Data layer
configuration. According to the CNN Input Data layer width configuration, RTL is implemented with half word write
with byte mode. It sends two downscaled pixel Byte values concatenated in single clock cycle.
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7.2.2. Post Processing CNN

CNN provides a total of 8232 [1372 x 6 (C, P, X, Y, W, H)] values, which are given to the det_out_filter module. The CNN
output data consists of the following parameters.

Table 7.2. Data Parameters of CNN Output
Parameter Description

C This parameter indicates the confidence of detected object class.

For each grid cell (14 x 14), one confidence value (16 Bit) for each anchor box (7) is provided making total
values of confidence 14 * 14 * 7 = 1372 from CNN Output.

P This parameter indicates the probability of detected object class.

For each grid cell (14 x 14), one probability value (16-bit) for each anchor box (7) is provided making total
values of probability 14 * 14 * 7 = 1372 from CNN Output.

X This parameter indicates the Relative X coordinate to transform the anchor box into a predicted
bounding box for detected object.

For each grid cell, one Relative X value (16-bit) for each anchor box is provided making total values of

14 * 14 * 7 = 1372 for X from CNN Output.

Y This parameter indicates the Relative Y coordinate to transform the anchor box into a predicted
bounding box for detected object.

For each grid cell, one Relative Y value (16-bit) for each anchor box is provided making total values of

14 * 14 * 7 = 1372 for Y from CNN Output.

w This parameter indicates the Relative W (Width) coordinate to transform the anchor box into a predicted
bounding box for detected object.

For each grid cell, one Relative W value (16-bit) for each anchor box is provided making total values of
14 * 14 * 7 = 1372 for W from CNN Output.

H This parameter indicates the Relative H (Height) coordinate to transform the anchor box into a predicted
bounding box for detected object.

For each grid cell, one Relative H value (16-bit) for each anchor box is provided making total values of
14 * 14 * 7 = 1372 for H from CNN Output.

Figure 7.4 shows the format of CNN output.

Output Data C P X Y W H X Y W H
Index No. |0-195(196-391(..[1176- 13711372 - 1567|1568 - 1763|....|2548 - 2743| 2744 - 2939 | 2940 - 3135|3136 - 3331|3332 - 3527| 3528 - 3723 [3724 - 3919 {3920 - 4115| 4116- 4311
Grid No. [0-195|0-195|.] 0-195 0-195 0-195 |..| D-1%5 0-195 0-195 0-195 0-195 0-195 0-195 0-195 0-195

Anchor No.| 1 2| 7 1 2 7 1 2

Figure 7.4. CNN Output Data Format

The primary functionality of the det_out_filter module is to capture the CNN valid output and modify it to work with the
crop_downscale_human_count module.
The det_out_filter module contains three sub-modules: det_sort_conf, det_st_class and det_st_bbox.

e 1372 values of confidence are passed to the det_sort_conf module. It sorts out the top 20 highest confidence
values and stores their indexes. Index values are passed to the det_st_class and det_st_bbox modules.

e 1372 values of probability are passed to the det_st_class module. It provides the valid class probability bitmap,
which is passed to the det_st_bbox module.

e 1372 x 4 values of coordinates are passed to the det_st_bbox module. It calculates the bounding box coordinates,
performs NMS and provides valid box bitmap.

The crop_downscale module contains logic for post processing.

e The draw_box module calculates the box coordinates for 89 x 896 image from 224 x 224 coordinates.

e Thelsc_osd_text module generates character bitmap for text display on HDMI.

e HDMI display logic implements muxing logic to provide final serial HDMI output interface.

This module implements logic for providing box coordinates, text and masking information to HDMI interface serially.
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7.2.2.1. Confidence Sorting

All input confidence values (1372) are compared with threshold parameter CONF_THRESH value. Confidence
values, which are greater than threshold are considered as valid for sorting.

The det_sort_conf module implements an anchor counter (0-1371), which increments on each confidence value. It
provides the index of confidence value given by the CNN output.

Two memory arrays are generated in this module: (1) sorted top 20 (TOP_N_DET) confidence value array, and (2)
sorted top 20 confidence index array.

For sorting, a standard sorting algorithm is followed. As input confidence values start arriving, each value is
compared with stored/initial value at each location of the confidence value array.

If the input value is greater than stored/initial value on any array location and lesser than stored/initial value of
previous array location, the input value is updated on current array location. The previously stored value of current
location is shifted into the next array location.

Refer to Figure 7.5 for sorting of new value of confidence into existing confidence value array. Calculated
confidence index (anchor count value) is also updated in the confidence index array along with the confidence
value array.

New Confidence Value = 40, Index=110
oLD ARRAY/_ UPDATED ARRAY

35 1 30 _> (40=30) -= update = 1 — a0 1 110
(40=20) & {40>30)
41 2 20 |=—»| -‘zupdate=0 —»| 30 |2 35
-= Store Prev Walue
40=10) & (40=20
66 3 0 |— F: :pda]te =(u >20) o 20 4 =
-= Store Prev Value
(40=0) & '(40=10)
0 4 0 ) -=update =0 —) 10 4 66
-= Store Prev Walue
0 20 ] 0 20 0
Confidence Confidence Confidence Confidence
Index Array Value Array Value Array Index Array

Figure 7.5. Confidence Sorting

This process is followed for all 1372 confidence values. This module provides 20 indexes (o_idx_00 to o_idx_19) as
output along with the count of valid indexes (o_num_conf). o_idx_00 contains highest confidence value index and
o_idx_29 contains lowest confidence value index.

7.2.2.2. Class Probability Detection

The det_st_class module captures the total NUM_CLASS * 1372 Probability Class values from the CNN output.
Currently, NUM_CLASS is set to 1 for a single class of Human Upper Body detection.

This module checks the class probability value for the sorted index numbers obtained from the det_sort_conf
module.

If multiple Probability Class exist (NUM_CLASS>1), this module compares the values of multiple probability classes
for each sorted confidence index value. It marks the maximum valued probability class as valid (1) and other
classes as invalid (0) for each sorted confidence index and stores this information in a bitmap memory array.
This array is provided as output to the det_out_filter module for differentiating bounding boxes of different
probability class by different color. Green box is used for probability class 1. Similarly, red and blue boxes can be
used for probability class 2 and 3 respectively.

For Single Probability Class, this module provides hardcoded value of 1 set as probability for each sorted
confidence index value in bitmap array. This only infers green boxes in final output.
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7.2.2.3. Bounding Box Calculation

SqueezeDet Neural Network for Object Detection is trained with seven reference boxes of pre-selected shapes having
constant W (Width) and H (Height). These reference boxes are typically referred as anchors.

Table 7.3. Pre-Selected Width and Height of Anchor Boxes

Anchor No. 1 2 3 4 5 6 7

W x H (pixel) 184x184 138x138 92x92 69x69 46x46 34x34 23x23

Anchors are centered around 14 x 14 grid cells of image. So each grid center has above seven anchors with pre-selected
shape. 14 x 14 are the number of grid centers along horizontal and vertical directions. The grid center (X, Y) pixel values
are shown in Table 7.4.

Table 7.4. Grid Center Values (X, Y) for Anchor Boxes

Grid No. 1 2 3 4 5 6 7 8 9 10 11 12 13 14
X (pixel) 15 30 45 60 75 90 105 119 134 149 164 179 194 209
Y (pixel) 15 30 45 60 75 90 105 119 134 149 164 179 194 209

CNN provides a total of 1372 (14 x 14 x 7) values of each relative coordinates X, Y, W, and H to transform the fixed size
anchor into a predicted bounding box. Input X, Y, W, and H values associated with top 20 sorted confidence indexes are
used for box calculation in det_st_bbox module.

Each anchor is transformed to its new position and shape using the relative coordinates as shown in logic 1.

LOGIC 1

X’ = X coordinate of Predicted Box

X = Grid Center X according to Grid number

W = Width of Anchor according to Anchor number
DeltaX = Relative coordinate for X (CNN output)

X" = X + W * DeltaX
Y’” =Y + H * DeltaY
W'= W * DeltaW
H’ = H * DeltaH

The predicted X', Y’, W’ and H’ values are clamped so that the box remains out of masking area. This is shown in logic 2.
LOGIC 2
If (X! < 0) = X'' = | Else if (X' > 223) => X'’ = 223 | Else X'’ = X’

0
If (Y <0) =>Y'"" =0 | Else if (Y’ > 223) => Y’’/ 223 | Else Y'' =Y’/
If (W < 0) => W'’ 0 | Else if (W' > 223) => W' = 223 | Else W' = W’

The final calculated X”, Y”’, W” and H”’ values for all the boxes are stored in separate memory array each having highest
confidence coordinate at 1%tindex and lowest confidence coordinate 20" index.

The Box coordinates are passed to the crop_downscale_human_count module after the NMS process.

7.2.2.4. NMS - Non Max Suppression

The NMS is implemented to make sure that in object detection, a particular object is identified only once. It filters out
the overlapping boxes using OVLP_TH_2X value.

NMS process is started when the CNN output data is completely received.

e The process starts from the box having highest Confidence coordinates: 0" location in X, Y, W, H array.

These coordinates are compared against the second highest Confidence coordinates: First locationin X, Y, W, H
array. From this comparison, Intersection and Union coordinates are found.

e  From these coordinates, Intersection and Union area are calculated between the highest confidence box and the
second highest confidence box as shown is Figure 7.6.
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Figure 7.6. Intersection-Union Area NMS

If Intersection Area * (OVLP_TH_2X/2) > Union Area, the box with lower confidence value is blocked in final output.
This NMS calculation is performed between all the combinations of two boxes.

After all combinations are checked, output array o_bbox_bmap contains boxes, which are correctly overlapped or
non-overlapped. o_out_en provides valid pulse for crop_downscale_human_count for further processing on these
box coordinates.

7.2.2.5. Bounding Box Upscaling

The draw_box module converts X, Y, W, and H input coordinates provided for 224 x 224 resolution into 896 x 896
resolution as shown in logic 3.

LOGIC 3

X1l = (X'’ - W''/2) * 4 + Horizontal-Mask (64/960)
Yl = (Y’ - H''/2) * 4 + Vertical-Mask (92)

X2 = (X'' 4+ W''/2) * 4 + Horizontal-Mask (64/960)
Y2 = (Y'’ + H''/2) * 4 + Vertical-Mask (92)

(X, Y) are considered as center of the Box of Width W and Height H for calculating extreme ends of the Box (X1, X2,
and Y1, Y2). For converting from 224 to 896, the coordinates are multiplied with 4. Required offset value is added
in coordinate calculations to keep the boxes out of mask area. X1, X2 and Y1, Y2 coordinates are calculated for
each Box.

Pixel Counter and Line Counter keeps track of pixels of each line and lines of each frame. Outer boundary of the
box and Inner boundary of the box are calculated when Pixel and Line counter reaches to coordinates (X1, X2) and
(Y1, Y2) respectively. Calculations are done as per logic 4.

LOGIC 4
Outer Box = (Pixel Count >= (X1 - 1)) and (Pixel Count <= (X2 + 1)) and

(Line Count >= (Y1 - 1)) and (Line Count <= (Y2 + 1))
Inner Box = (Pixel Count > (X1 + 1)) and (Pixel Count < (X2 - 1)) and

(Line Count > (Y1 + 1)) and (Line Count < (Y2 - 1))
Each Bounding Box is calculated by removing the intersecting area of outer and inner box. Box is only displayed if
Box-Bitmap for that box is set to 1 (from det_st_bbox module). Box on calculations are as done as logic 5.

LOGIC 5
Box on[1]
Box on[2]

Outer Box[1l] and ~Inner Box[l] and Box-Bitmap[1l]
Outer Box[2] and ~Inner Box[2] and Box-Bitmap[2]

Box on[20] = Outer Box[20] and ~Inner Box[20] and Box-Bitmap[20]
The o_box_obj signal is asserted when any of the above Box_on signal is set, which is then connected to green_on
signal and processed for Bounding Box display via HDMI.
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7.2.2.6. OSD Text Display
e Thelsc_osd_text module provides bitmap of each ASCII character to be displayed with specified position on
screen. It takes count of detected Humans and Threshold value as input.

e It sets an output signal (text_on) when text is to be displayed on HDMI. When text_on is set, RGB value for that
pixel location is assigned FFF value (While color) and sent to HDMI output instead of original pixel value.

7.2.2.7. HDMI Display Management

RGB data is passed serially to HDMI and it is multiplexed by following values.

e If Signal Text is on (text_on) — Pass all RGB value as FFF for White color display.

e If Signal Green is on (green_on) — Pass only Green pixel value as FFF. Keep Red and Blue values as 0.
e If Signal Mask is on (fmask_on) — Pass darker RGB pixel values.

e  Else —Pass Input RGB Data as it is.

7.2.2.8. Inference Time Calculation

e The time taken by a trained neural network model to infer/predict outputs after obtaining input data is called
inference time. The process of this calculation is explained as follows.

e The inference time is calculated by implementing a counter to store the count of CNN engine cycles per frame.

e  When signal i_rd_rdy (that is o_rd_rdy coming from CNN engine) is high, the CNN engine indicates that it is ready
to get input and when it is low, the engine indicates that it is busy.

e  Wheni_rd_rdy signal is low, the CNN counter begins and stops when the i_rd_rdy signal goes high again indicating
that previous execution is over and the CNN is ready for new input.

e Asshown in Figure 7.7 when rdy_h2l (ready high-to-low) pulse is asserted, the CNN Up-counter starts from 1 and
the count value increases till i_rd_rdy is not high again. The count value is stored in (count).

e Similarly, when rdy_I2h (ready low-to-high) pulse is asserted, the Up-counter stops and the final CNN count value
is obtained (cnn_count).

assign rdy 12h = 1 rd rdy & ~rdy;
assign rdy h2l = ~i rd _rdy & rdy;

// Counter to calculate individual frame inference time
assign count ¢ = (o_rd_done & rdy h2l) ? 27°dl : (i_rd_rdy) ? count : (count + 27°'dl);

// Store individual cnn frame counter
assign cnn_count ¢ = rdy 12h 7 count : cnn_count;

Figure 7.7. CNN Counter Design

e The methodology used to obtain stable inference time is to calculate inference time per frame and obtain the
average inference time value after 16 CNN frames are over as discussed below.

e After completion of every frame, the new count value (cnn_count) obtained as explained above is added to the
previous value and stored in (cnn_adder).

e Aframe counter keeps monitoring the frame count and after 16 frames when the frame count is done, this
cnn_adder value is reset as shown in Figure 7.8.

// Frame counter to calculate CNN frames upto 16 (© - 15)
assign frame counter ¢ = (rdy _12h_rr)? (frame counter + 4'dl) : frame_counter;

// keep adding indiviual cnn frame counter for 16 frames. Then clear to ©
assign cnn_adder ¢ = (count_done)? 31'd0 : (rdy 12h r) ? (cnn_adder + {4'd@,cnn_count}) : cnn_adder;

// Counter addition done when 111 16 cnn frame counter values are added and averaged
assign count done = (frame_counter == 4'd15) & (rdy 12h rr);

Figure 7.8. Inference Time Calculation
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To get the average inference time value (avg_inf_time_hex) after frame count is done, the final cnn_adder value is
divided by 16 as shown in Figure 7.9.

// Average Inference Time calculated by dividing by 16
assign inf time c = (count _done)? cnn_adder([30:4] : inf time;

// 32 Bit average Inference time in Hex
assign avg_inf time hex = {5'd@,inf_time};

Figure 7.9. Average Inference Time Calculation

Using Lattice Multiplier library module, this average inference time value is multiplied by INF_MULT_FAC, a
parameter indicating inference multiplying factor explained in Table 7.1.

The inference time in millisecond (inf_time_ms) is obtained by dividing the output obtained from this multiplier by
2731 as per the Q-Format, shown in Figure 7.10.

All the above obtained values namely the CNN count, average inference time, and inference time in millisecond are
passed on to Isc_osd_text_human_count module for getting bitmap to display characters.

assign inf time ms = inf time mult([46:31];

Figure 7.10. Inference Time in Millisecond

7.2.2.9. Inference Time Display Management

This module mainly consists of a DPRAM which holds the characters at pre-defined address positions indicated by
text_addr and an 8 x 8 font ROM which provides the bitmap of these characters for HDMI display.

This module basically functions by using two entities. One is the position of the character where it has to be
displayed, and the other is by reading the ASCII value of the character to be displayed.

For this purpose, once the CNN count, individual frame inference time and the inference time in millisecond values
are obtained, they are converted from hex into ASCII values as shown in Figure 7.11.

The average inference time input values (i_avg_inf_time_hex) are converted from hex to ASCII values as shown in
Figure 7.11. To display eight characters of this value on HDMI, this input is stored in respective r_avginfhex_ch. The
characters obtained by adding 7’h30 and 7°’h37 are shown in Table 7.5.

r_avginfhex_che <= (i _avg_inf_time hex[31:28] > 4'd9)? I.i_a\.fg_inf_‘cime_hex[31:28]l + 7'h37) : (i_avg_inf_time hex[31:28] + 7°'h30);
r_avginfhex_chl <= (i_avg_inf_time_hex[27:24] > 4'd9)? (i_avg_inf_time hex[27:24] + 7'h37) : (i_avg_inf_time hex[27:24] + 7'h30);
r_avginfhex_ch2 <= (i _avg_inf_time hex[23:20] > 4'd9)? (i_avg inf_time hex[23:20] + 7'h37) : (i_avg_inf time hex[23:28] + 7'h36);
r_avginfhex_ch3 <= (i_avg_inf_time_hex[19:16] > 4'd9)? (i_avg_inf_time hex[19:16] + 7'h37) : (i_avg_inf_time hex[19:16] + 7'h306);
r avginfhex ch4 <= (1 avg inf time hex[15:12] = 4'd9)7 (i avg inf time hex[15:12] + 7'h37) : (1 avg inf time hex[15:12] + 7'h30);
r_avginfhex_ch5 <= (i_avg_inf_time_hex[11:8] > 4'd9)? (i_avg_inf time hex[11:8] + 7'h37) : (i_avg_inf_time hex[11:8] + 7'h30);
r avginfhex ché <= (i avg inf time hex[7:4] = 4'd9)? (i avg inf time hex[7:4] + 7'h37) : (i avg inf time hex[7:4] + 7'h30);
r_avginfhex_ch? <= (i_avg_inf_time_hex[3:0] > 4'd9)? (i_avg_inf time hex[3:0] + 7'h37) : (i_avg_inf_time hex[3:0] + 7'h30);
Figure 7.11. Average Inference Time Value to ASCII Conversion
Table 7.5. Signal Values to ASCIl Conversion

CHARACTERS FOR DISPLAY VALUE TO BE ADDED TO SIGNAL ASCII HEX VALUE ASCII DECIMAL VALUE

1 7’h30 31 49

2 7’h30 32 50

3 7’h30 33 51

4 7’h30 34 52

5 7’h30 35 53

6 7’h30 36 54

7 7’h30 37 55
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A 7’h37 41 65
B 7’'h37 42 66
C 7'h37 43 67
D 7’h37 44 68
E 7’h37 45 69
F 7’h37 46 70

e Similarly to display eight characters of individual frame inference time, the input signal i_inf_time_hex is converted
from hex to ASCII and stored in respective r_infhex_ch signal as shown in Figure 7.12.

e Inthe same way to display four characters of inference time in ms, the input signal i_inf_ms is converted from hex
to ASCIl and stored in respective r_inf_ms signal as shown in Figure 7.13.

r_infhex ch® <= (i_inf_time hex[31:28] = 4'd9)? (i_inf_time hex[31:28] + 7'h37) : (i_inf_time_hex[31:28] + 7'h30);
r_infhex chl <= (i_inf_time hex[27:24] = 4'd9)? (i_inf_time hex[27:24] + 7'h37) : (i_inf_time_hex[27:24] + 7'h30);
r_infhex ch2 <= (i_inf_time_hex[23:20] = 4'd9)? (i_inf_time_hex[23:20] + 7'h37) : (i_inf_time_hex[23:20] + 7'h30);
r_infhex ch3 <= (i_inf time hex[19:16] > 4'd9)? (i_inf time hex[19:16] + 7'h37) : (i_inf time hex[19:16] + 7'h30);
r_infhex_ch4 <= (i_inf_time_hex[15:12] = 4'd9)? (i_inf_time_hex[15:12] + 7'h37) : (i_inf_time_hex[15:12] + 7'h30);
r_infhex ch5 <= (i_inf_time hex[11:8] = 4'd9)? (i_inf time hex[11:8] + 7'h37) : (i_inf time hex[11:8] + 7'h36);
r_infhex ché <= (i_inf time hex[7:4] > 4'd9)? (i_inf time hex[7:4] + 7'h37) : (i_inf time hex[7:4] + 7'h3e);
r_infhex ch7 <= (i_inf time hex[3:0] > 4'd9)? (i_inf time hex[3:0] + 7'h37) : (i_inf time hex[3:0] + 7'h30);

Figure 7.12. CNN Count Values to ASCIl Conversion
r infms ch@ == (i_inf_time ms[15:12] > 4'd9)7 (i_inf_time ms[15:12] + 7'h37) : (i_inf time ms[15:12] + 7'h30);
r infms chl == (1 inf time ms[11:8] > 4°d9)? (i inf time ms[11:8] + 7'h37) : (i _inf time ms[11:8] + 7'h38);
r infms ch2 <= (i inf time ms[7:4] = 4'd9)? (i inf time ms[7:4] + 7'h37) : (i inf time ms[7:4] + 7'h38);
r infms ch3 <= (1 _inf time ms[3:0] > 4'd9)? (i inf time ms[3:0] + 7'h37) : (i_inf time ms[3:0] + 7'h30);

Figure 7.13. Inference Time in Millisecond Values to ASCII Conversion

e The positions where these values have to be displayed are given using text_addr signal as shown in Figure
7.14. The use of these locations is shown in Figure 7.15 and Figure 7.16. A memory initialization file
human_count.mem is used by Lattice Diamond tool to store characters at address locations for display.

// Hex counter display
assign w_avginfhex_ch® pos
assign w avginfhex chl pos (text addr 13'd7141)
assign w avginfhex ch2 pos (text addr == 13'd7142);
assign w_avginfhex_ch3 pos = (text addr == 13'd7143);
assign w_avginfhex_ch4 pos (text_addr 13'd7144) ;
assign w avginfhex ch5 pos (text addr 13'd7145) ;
assign w avginfhex ché pos (text addr == 13'd7146);

(text_addr 13'd7140) ;

assign w_avginfhex_ch7 pos = (text addr == 13'd7147);
assign w_infhex ch® pos = (text addr == 13'd7116);
assign w_infhex chl pos = (text_addr == 13'd7117);
assign w_infhex ch2 pos = (text_addr == 13'd7118);
assign w_infhex_ch3_pos = (text_addr == 13'd7119);
assign w_infhex ch4 pos = (text addr == 13'd7120);
assign w_infhex ch5 pos = (text_addr == 13'd7121);
assign w_infhex ché pos = (text_addr == 13'd7122);
assign w_infhex_ch7_pos = (text_addr == 13'd7123);

// Milisecond display

assign w_infms ch® pos
assign w_infms_chl_pos
assign w_infms ch2 pos
assign w_infms ch3 pos

(text addr == 13'd7149);
(text_addr 13'd7150);
(text addr 13'd7151) ;
(text addr == 13'd7152);

Figure 7.14. Text Address Positions to Display Input Values
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e The address location structure for displaying average inference time (of 16 CNN frames) and inference time in
millisecond values along with their strings are stored in human_count.mem is shown in Figure 7.15.

Characters stored as ASCII Values in human_count.mem file for string display

Avg Characters in human_count.mem file
Inf except Inf time value
Character A v £ 1 n T i m a Time Inf m 5 ]
Time
Address in decimal | 7126 F127 | 7128 | 7130 | 7131 | 7131 | 7134 | F135 | 7136 | 7137 | Fi38 7140 F148 | 7148 | 7153 | 7154 | 7155
_‘T:I_' ta
7147 7152

Figure 7.15. Address Locations to Display Individual Frame Time and Inference Time with String in HDMI

e The address location structure for displaying individual frame inference time values along with the string are
stored in human_count.mem is shown in Figure 7.16.

Characters stored as ASCIl Values in human_count.mem file for string display * Individual
Frame
Character 1 f T i [ Inf
Time
Address 7106 7108 | 7110 | 7111 | 7112 | 7113 | 7114 | 716
in decimal ?133

Figure 7.16. Address Locations to Display CNN Count Value and its String in HDMI Output

e Todisplay the input values in address locations shown in Figure 7.15 and Figure 7.16, their ASCII values obtained as
shown in Table 7.5, Figure 7.12, and Figure 7.13 are sent to the 8 x 8 font ROM with the help of font_char signal to
obtain the bitmap for HDMI output as shown in Figure 7.17.

assign font char

(r face ch® pos )7 r face cho :
(r face chl pos )7 r face chl :
(r th sign pos )7 r_th 51gn :
(r th che pos )7 r _th che :
(r th chl pos )7 r “th chl :
(r th ch2 pos ? r th ch2 :
(r_ th ch3 pos )7 r_ th ch3 :
//Inference Time Lo ogi

(r avginfhex ch® pos )?
(r avginfhex chl pos )?
(r avginfhex ch2 pos )7
(r_avginfhex_ch3_pos )7
(r avginfhex ch4 pos )?
(r avginfhex ch5 pos )?
|7
|
|
|
|
|
|
|
|
|

(r_avginfhex_ché_pos

(r_avginfhex_ch7_pos )7

(r_infhex_ch@_pos
(r infhex chl pos
(r_infhex_ch2_pos
(r_infhex_ch3 pos
(r_infhex_ch4 pos
(r _infhex ch5 pos
(r_infhex_ch6_pos
(r_infhex_ch7_pos

r avginfhex ch® :
r avginfhex chl :
r avginfhex ch2 :
r_avginfhex ch3 :
r avginfhex ch4 :
r avginfhex ch5 :
r avginfhex ché :
r_avginfhex ch? :
}? r_infhex_ch@ :
? r_infhex_chl :
? r_infhex ch2 :
)7 r_infhex ch3 :
! r_infhex_ch4 :
)7 r_infhex ch5 :

)7 r infhex ché :

? r infhex ch? :

(r_infms_ch@_pos
(r_infms_chl_pos
(r infms ch2 pos
(r_infms_ch3_pos

)7 r_infms_che :
}7 r_infms chl :
)7 r_infms ch2 :
)7 r_infms_ch3 :
text data[6:0];

Figure 7.17. Bitmap Extraction from Font ROM
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8. Creating FPGA Bitstream File

This section describes the steps to compile RTL bitstream using Lattice Diamond tool.

To create the FPGA bitstream file:

1. Open the Lattice Diamond software.

# Lattice Diamond - Start Page - x
File Edit View Project Design Process Tools Window Help
A-rE-rda g rayPh @GERI|Q|I] = =]
EFFRFGoEEGALlsQ<sDEY FEEEEG
& X| F start Page [J & %
Project: User Guides Reference Guides -
[ open... Lattice Diamond Release Notes Strategy
B new... Lattice Diamond User Guide Constraints
[ 1mport ispLEVER Project... Lattice Synthesis Engine for Diamond User  Hardware How-To
Recent Proj Lattice Modules
.ecen! rojects:
uip hur:ar\ ot Managing P'“fJE':tS FPGA Libraries (HTML version)
= 'fﬁ k; s Platform Designer User Guide FPGA Libraries (PDF version)
vip_face_key_ep
’ Entering the Design Command Line
Object_Count
[ Object Clarity Designer User Manual ol Commande
[FE Object_Count Simulating the Design Glossary
Applying Design Constraints Desian Tool Reference
Implementing the Design
Software Update Center Tutorials
Using Incremental Design Flow
Currently running Lattice Diamond software version: Lattice Diamond Tutorial
Analyzing Static Timing
3.11.0.396.4 Lattice Synthesis Engine Tutorial
Mo oot avaiabl Analyzing Power Consumption
o updates available . .
ing Si ; FPGA Design Guide
Last chedk time: Mon Sep 16 15:43:09 2019 Analyzing Signal Integrity Design Planning
Programming the FPGA v
Filelist ~ Process Hierarchy
output 8 x
TdConscle  Output  Emor  Waming  Info  FindResults
Ready Mem Usage: 162,200 K

Figure 8.1. Lattice Diamond — Default Screen

2. Click File > Open > Project.
3. Open the Diamond project file for ECP5 Face Identification Demo RTL.

- X
DhieERAKAY
BEhiEZids Qs @
SEEE # Open Project % & x
« « 4 > ThisPC » Local Disk(C) > RIL » v @ | searchRIL r =
Reference Guides
Organize v Newfolder e e ™ @ Strategy
o ~ Constraints
Name Type
# Quick access iamond User Hardware How-To
ddr3_ip_inst File folder Lattice Modules
& OneDrive ecps File folder FPGA Libraries (HTHL version)
FPGA Libraries (PDF version)
B This PG impl1 Fille folder
1008 Isc_ml File folder Command Line
ects
e ! stc File folder el Commands
I Desktop Vip_human_count_ter.dir File folder Glossary
Documents [ vip_human_count.Idf LDF File Design Tool Reference
¥ Downloads Tutorials
Lattice Diamond Tutorial
b Music
Lattice Synthesis Engine Tutorial
&=| Pictures
FPGA Design Guide
B videos o
esign Planning .
%, Local Disk (C)
Filelist  Process  Hierarchy
= Local Disk )
output v < > 8 x
File name: |vip_human_count.Idf | [Project Files (Idf) -
TdConsole  Output Eror  Warning  Info  FindResults
Ready Mem Usage: 213,192 K

Figure 8.2. Lattice Diamond — Open ECP5 Face Identification Diamond Project File
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4.

Double-click Bitstream File to trigger bitstream generation.

* Lattice Diamond - Reports - X
File Edit View Project Design Process Tools Window Help
BrEg-d B ¥ M [ aada ]
“ECEEL A CEEGE QB EFEuEE @
Process 8 X} StartPage
~ % Synthesize Design = 5
% synplify Pro
N ~
{ Translate Design Design summary
~ % Map Design ~ [ Project
%L Map Trace sty Module Wame: |vip_human_count Synthesis:
[0 & Verilog Simulation File e Process Reports
[0 2 VHDL Simulation File & Synplify Pro Implementation | impll Strategy Name:
. Hame:
v % Place & Route Design ¥ map
%{ Place & Route Trace I\ Place & Route Last Process: State:
[ 2 170 Timing Analysis % Signal/Pad Target Device: | LFESUM-8SF-8BG756C Device Family:
v 2 Bitstream/JEDEC
- EXF‘T Files - = X Device Type: |LFESUM-85F Package Type:
[ 2 IBiS Model Analysis Reports
[ 2 Verilog Simulation File # Map Trace Performance |8 Operating conditions:
[0 2 VHDL Simulation File #] Place & Route Trace aren
% Bitstream File [ 170 Timing Analysis Logic vip_human_count. 1pf
[0 2 PROMFile v 7 Tool Reports preference
[M 170 550 Analysis Jilzs
#] Hierarchy Parsing Report Physical impll/vip_human count_impll.prf
[ PI0 DRC Preference
# TCL Command Log file: v
FieList | Process | Hierarchy—Post Map Resources [ ECO Editor Changelog v | < >
Output 8
INFO - C:/Users/softnautics/Desktop/kishan/mobilenet/vip human count ipv2 1 mobilenst/vip_human_count/Src/vip_common/lsc_i2cm.v(3,8-3,16) (VERI-101g) compiling medule lsc_iZem
INFO - C:/Users/softnautics/Desktop/kishan/mobilenet/vip human_count ipv2_l mobilenet/vip_human_count/src/vip common/lsc_iZem.v(3,1-26€,10) (VERI-9000) elaborating medule 'lsc_iZem'
INFO - C:/Users/softnautics/Desktop/kishan/mobilenet/vip human_count ipvZ_ L mobilenet/vip_human_count/lsc_ml/can_accel/can_accel top.v(l,-1,21) (VERI-1012) compiling module cnn_accel_top
INFO - C:/Users/softnautics/Desktop/kishan/mobilenet/vip human_count_ipv2 L mobilenst/vip_human_count/1sc_ml/cmn_accel/cmn_accel_top.v(l,l-253,10) (VERI-9000) elaborating module
"chn_accel_top'
INFO - C:/Users/softnautics/Desktop/kishan/mobilenet/vip human _count ipv2 1 meobilenet/vip_human_count/lsc_ml/lsc_ml.v(ll,g-11,14) (VERI-1012) compiling module lsc_ml
INFO - C:/Users/softnautics/Desktop/kishan/mobilenet/vip human_count_ipvZ_l_mobilenet/vip_human_count/lsc_ml/lsc_ml.v(l1,1-11§,10) (VERI-9000) elabeorating module 'lsc_ml'
Done: design load finished with (0) errors, and (49) warnings
Td Console Output Error Warning® Info® Find Results
Ready Mem Usage: 345,184

Figure 8.3. Lattice Diamond - Trigger Bitstream Generation

5.

The Lattice Diamond tool displays Saving bit stream in ... message in the Reports window as shown in Figure 8.4.

The bitstream is generated at Implementation Location as shown in Figure 8.3.

# Lattice Diamond - Reports - x
File Edit View Project Design Process Tools Window Help
D@ e ¥ M [E] Qaegaa
‘EOEHBE AW G GRzusesls®Y @
Process B X ([ StartPage Reports [0
v % Synthesize Design = =
% Synplify Pro
%{ Translate Design Design Summary
v % Map Design ~ [ Project
£ Map Trace L & Project summary Module Name: |vip human_count Synthesis: Synplifye
[ & Verilog Simulation File [ Process Reports ———
[0 & VHDL Simulation File & synpify Pro P | ™! Strategy Name: Strategyl
" Name:
v % Place & Route Design # Mep
¢ Place & Route Trace A\ Place & Route Last Process: |Bitstream File State: Passed
[0 2 /0 Timing Analysis % Signal/Pad Target Device: | LFESUM-E5F-3BG7S6C Device Family: ECESUM
v 2 ExportFil Bitstream/JEDEC
2 ExportFiles - - . X JE——
02 1815 Model v = Ansiysis Reports Device Type: |LFESUM-8SF Package Type: CABGATSE
[0 2 Verilog Simulation File Map Trace Performance |3 Operating conditions: coM
[J 2 VHOL Simulation File & Place & Route Trace UESCED
%/ Bitstream File [ /0 Timing Analysis Logic vip_human_count . 1pf
O 2 EROM File v 1 Tool Reports preference
[% 170 550 Analysis file:
# Hierarchy Parsing Report Physical imp11/vip_human_count_impll.prf
[™ P10 DRC Preference
# TCL Command Log Iils:
[ ECO Editor Change Log Product 3.11.0.396.4 Patch Version:
v I Messages Version:
) All Messages Updated: 2015/09/16 16:00:17 o
) User Defined Filters < 5
Fil Pr Hierarchy-—Fost Map Reso
Cutput 8 x

Saving bit stream in "vip_human_count_impll.bit”.

Total CEU Time: 38 secs
Total REAL Time: 40 secs
Peak Memory Usage: 871 MB

Dons: completed successfully
v
TdConsole  Qutput Emor  Warning®  Info  Find Resuits
Ready Mem Usage: 339,080 K
Figure 8.4. Lattice Diamond — Bit File Generation Report Window
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9. Programming the Demo

9.1. Programming the CrossLink™ SPI Flash

9.1.1. Erasing the CrossLink SRAM Prior to Reprogramming

If the CrossLink device is already programmed (either directly or loaded from SPI Flash), erase the CrossLink SRAM
before reprogramming the CrossLink SPI Flash. Keep the board powered on to prevent reloading on reboot.

To erase the CrossLink device SRAM:
1. Start Diamond Programmer. In the Getting Started dialog box, select Create a new blank project.

i+ Diamond Programmer - Getting Started ? >

Select an Action

O Create a new project from a JTAG scan

Cable: | HW-USBN-2B (FTDI) Port: |FTUSB-0 Detect Cable

(@ cCreate a new blank project

O Open an existing programmer project

Figure 9.1. Diamond Programmer — Default Screen

2. Click OK.

3. In the Diamond Programmer main interface, select LIFMD in Device Family and LIF-MD6000 in Device as shown in
Figure 9.2.

ic_j: Diamond Programmer - Untitled *

File Edit View Design Help

P2 B2 G 9 E
Enable Status Device Family Device
2| LIFMD LIF-MD6000

Figure 9.2. Diamond Programmer — Device Selection

4. Click the CrossLink row and select Edit > Device Properties.

5. Inthe Device Properties dialog box, select SSPI SRAM Programming in Access mode and Erase Only in Operation as
shown in Figure 9.3.
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iy, LIFMD - LIF-MD6000 - Device Properties

X}

General Device Information |

Device Operation

Access mode: SSPI SRAM Programming ']
Operation: Erase Only X

[ o

) [ ]

Figure 9.3. Diamond Programmer — Device Operation

6. Click OK to close the Device Properties dialog box.

7. Inthe Diamond Programmer main interface, click the Program button ¥ to start the erase operation.

Note: If you power OFF/ON the board, the SPI Flash reprograms the CrossLink device. In this case, you must repeat

steps1to 7.

9.1.2. Programming the CrossLink VIP Input Bridge Board

To program the CrossLink VIP Input Bridge Board:

1. Ensure that the CrossLink device SRAM is erased by performing the steps in Erasing the CrossLink SRAM Prior to

Reprogramming.

2. Inthe Diamond Programmer main interface, click the CrossLink row and select Edit > Device Properties to open the

Device Properties dialog boxes shown in Figure 9.4.

. LIFMD - LIF-MDE0DD - Device Properties

General Device Information
Device Operation
Access mode:

Operation:

Programming Options

SPI Flash Programming -

SPI Flash Erase Program,Verify

Programming file: |NT,‘senai21,‘releasefBitst'eameuaI_Camera_to_ParaIIeI_Crosinnk.bit |

Device Options

|:| Reinitialize part on program error

SPI Flash Options

Family: SPI Serial Flash -
Vendor: Micran -
Device: SPIM250128A A
Package: 8-pin 508 -
SPI Programming

Data file size (Bytes): | 163544 Load from File

Start address (Hex): 0x00000000 -

End address (Hex): 0x00020000 -

|:| Erase SPI part on programming error

[ secure SPI flash golden pattern sectors

Cancel

Figure 9.4. Diamond Programmer — Selecting Device Properties Options for Crosslink Flashing

© 2020 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.

FPGA-RD-02195-1.0

57


http://www.latticesemi.com/legal

3. Apply the settings below.

e Under Device Operation, select the options below:

e Access Mode - SPI Flash Programming

e  Operation — SPI Flash Erase, Program, Verify

e Under Programming Options, select the bitstream file
~/Demonstration/Dual_Camera_to_parallel_Crosslink.bit available in downloaded demo directory in

Programming file.

e  For SPI Flash Options, refer to Table 9.1:

Table 9.1. Diamond Programmer — SPI Flash Options

= LATTICE

Item Rev B Rev C - Option 1 Rev C — Option 2
Family SPI Serial Flash SPI Serial Flash (SPI Serial Flash SPI Serial Flash (SPI Serial Flash
Beta for Diamond 3.10 SP1 or Beta for Diamond 3.10 SP1 or
earlier) earlier)
Vendor Micron Micron Macronix
Device SPI-M25PX16 SPI-N25Q128A MX25L12835F
Package 8-pin SO8W 8-pin SOP2 8-Land WSON

e (Click Load from File to update the Data file size (Bytes) value.

e  Ensure that the following addresses are correct:
e  Start Address (Hex) — 0x00000000

e End Address (Hex) — 0x00020000

4. Click OK.

In the Diamond Programmer main interface, click the Program button &

to start the programming operation.

After successful programming, the Output console displays the result as shown in Figure 9.5.

Output

Verifying...

Finalizing...

INFO - Execution time: 00 min : 06 sec
INFO - Elapsed time: 00 min : 06 sec

INFO - Operation: successful.

Output Tel Console |

Figure 9.5. Diamond Programmer — Output Console
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9.2. Programming ECP5 VIP Processor Board

Both the CrossLink VIP Input Bridge Board and the ECP5 VIP Processor Board must be configured and programmed. Also,
the demo design firmware must be programmed onto the MicroSD Card which is plugged into the MicroSD Card Adaptor
Board.

9.2.1. Erasing the ECP5 Prior to Reprogramming

If the ECP5 device is already programmed (either directly or loaded from SPI Flash), erase the ECP5 SRAM before
reprogramming the ECP5 SPI Flash. Keep the board powered on to prevent reloading on reboot.

To erase the ECP5 SRAM:
1. Launch Diamond Programmer with Create a new blank project.

i,.i Diamond Programmer - Getting Started ? X

Select an Action

O Create a new project from a JTAG scan

Cable:  HW-USBN-2B (FTDI) Port: |FTUSB-0 Detect Cable

@ Create a new blank project

O Open an existing programmer project

Figure 9.6. Diamond Programmer — Default Screen

2. Click OK.
3. Inthe Diamond Programmer main interface, select ECP5UM in Device Family and LFESUM-85F in Device as shown
in Figure 9.8.
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 Diamond Programmer * - o x
Eile Edit Yiew Design Help
al-1°! BRI ESE
Enable  Status Device Family Device Operation Fie Hame File Date/Time  Checksum  USERCODE G
Cable Setings
=] EcPsuM < LFEsuM-25F Program
Generic ITAG Devee a Detect Cable
P
ECPSUMSG Coble: HW-USEN-20 (FTON ~
) Fort: FTuse-s -
MachoaL
MachiX03LF Custo: port;
Frogramming Speed Settings

(@ use defaul Clock Drdar
() Use custom Clock Divider

Vo setungs
(® Use default 10 settings

Catle and 10 Setings

© use custom 10 secings

output
Lattica VM Drivers detected (HW-DUH-SC (Paraliol]) Message
Programmer device databas loaded

Emor | Weming  Info

Quput | Td Console
Ready

Q Type here to search

Figure 9.7. Diamond Programmer — Device Family Selection

v Design  Window Help

I rrrl-

Device Family Device

ECPSUM LFESUM-85F "J

LFESUM-25F
LAESUM-25F
LFESUM-45F
LAESUM-45F

LAESUM-85F

Figure 9.8. Diamond Programmer — Device Selection

4. Click the ECP5 row and select Edit > Device Properties.
5. Inthe Device Properties dialog box, select JTAG 1532 Mode in Access mode and Erase Only in Operation (shown in

Figure 9.9).

Enable Status  Device Family Device Operation File Name
¥ PASS  ECP5UM LFESUM-B5F Erase Only ..uments/VIP LF-EVDK1-EVN-
ol

iph ECPSUM - LFESUM-85F - Device Properties

General | Device Information

Device Operation

Access mode: JTAG 1532 Mode v]

Operation: Erase Only -

Figure 9.9. Diamond Programmer — Device Operation
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6. Click OK to close the Device Properties dialog box.

Ak
7. Inthe Diamond Programmer main interface, click the Program button ** to start the Erase operation.

Note: If you power OFF/ON the board, the SPI Flash reprograms the ECP5 device. In this case, you must repeat
steps1to7.

9.2.2. Programming the ECP5 VIP Processor Board

To program the ECP5 VIP Processor Board:

1. Ensure that the ECP5 device is erased by performing the steps in Erasing the ECP5 Prior to Reprogramming.
2. Inthe Diamond Programmer main interface, click the ECP5 row and select Edit > Device Properties

3. The Device Properties dialog box opens. Select human count demo bit file in Programming file: section as shown in
Figure 9.10 (Rev B).

id ECPSUM - LFESUM-85F - Device Properties ? et

General Device Information
Device Operation
Arccess mode: SPI Flash Background Programming -

Operation: SPI Flash Erase,Program,Verify -

Programming Options

Programming file: Bitstream/HumanCounting_ResMet_Bitstream. bit | ...

SPI Flash Options

Family: SPI Serial Flash -
Vendor: Micraon -
Device: M250Q 1284 b
Package: &-pin 508 -
SPI Programming
Data file size (Bytes): | 1939633 Load from File
Start address (Hex): 0x00000000 -
End address (Hex): 0x00 100000 -

|:| Erase SPI part on programming error

[] secure SPI flash golden pattern sectors

Carcel

Figure 9.10. Diamond Programmer - Selecting Device Properties Options for ECP5 Flashing
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4. Apply the following settings:
e Under Device Operation, select the options below:
e Access Mode - SPI Flash Background Programming
e Operation — Erase, Program, Verify

e Under Programming Options, select the appropriate bitstream file for respective demo in Programming file.
e  For SPI Flash Options, refer to Table 9.2:

Table 9.2. Diamond Programmer — SPI Flash Options

Item Rev B Rev C - Option 1
Family SPI Serial Flash SPI Serial Flash
Vendor Micron Macronix
Device SPI-N25Q128A MX25L12835F
Package 8-pin SO8 8-Land WSON

e Click Load from File to update the Data file size (Bytes) value.
e  Ensure that the following addresses are correct:

e  Start Address (Hex) — 0x00000000

e End Address (Hex) — 0x001D0000

5. Click OK.

In the Diamond Programmer main interface, click the Program button “ to start the programming operation.

After successful programming, the Output console displays the result as shown in Figure 9.11.

Output

Disabling...

Verifying...

INFO - Execution time: 00 min : 23 sec
INFO - Elapsed time: 00 min : 23 sec

INFO - Operation: successful.

1

Output | Tcl Console
Ready

Figure 9.11. Diamond Programmer — Output Console
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9.3. Programming the MicroSD Card Firmware
To write the image to the MicroSD Card:

1. Download and install the Win32diskimager Image Writer software from the following link:
https://sourceforge.net/projects/win32diskimager/.

2. Use Win32diskimager to write the appropriate Flash image (binary firmware) file to the SD memory card. You may
need a SD Card reader and adapter to connect the MicroSD card to PC for firmware flashing.

In Win32 Disk Imager, select the image file for respective demo firmware .bin file as shown in Figure 9.12.
Select the Card Reader in Device as shown in Figure 9.12.
5. Click Write.

%2 Win32 Disk Imager - 1.0 - O x

Image File Device

Select Binary File —‘tafLSCC{SensAI3DfReIeasefResNethitstreamﬂ-lumanCc-unﬁng_ResNet.I:-in| : = Select Card Reader

Hash

Mone > |  Generate Copy

[] Read only Allocated Partitions

Progress

Cancel Read Write Verify Only Exit

Waiting for a task.

Write

Figure 9.12. Win32 Disk Imager

Optionally, you can click Verify Only to confirm whether firmware write is correct.
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10. Running the Demo

To run the demo:

1. Insert the configured MicroSD Card into the MicroSD Card Adapter and connect it to the Embedded Vision
Development Kit.

Figure 10.1. Connecting the MicroSD Card

2. Cycle the power on the Embedded Vision Development Kit to allow the ECP5 and CrossLink devices to be
reconfigured from Flash.

3. Connect the Embedded Vision Development Kit to the HDMI monitor. The camera image is displayed on monitors
as shown in Figure 10.2.

Figure 10.2. Running the Demo

4. The demo output contains bounding boxes for detected humans in a given frame. It also displays the total number
of detected humans in a given frame on HDMI output.
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Appendix A. Other Labelling Tools

Table A.1 provides information on other labelling tools.

Table A.1. Other Labelling Tools

Software Platform License Reference Converts Notes
To
annotate-to- | Ubuntu/Windows | No License | https://github.com/SaiPrajwal95/annotate-to- | KITTI Python based
KITTI (Python based (Open KITTI CLI utility that
utility) source you can clone
GitHub and launch.
project)
LabelBox JavaScript, HTML, | Cloud or https://www.labelbox.com/ json, csv, Web
CSS, Python On- €oco, voc application
premise,
some
interfaces
are
Apache-2.0
LabelMe Perl, JavaScript, MIT http://labelme.csail.mit.edu/Release3.0/ xml Converts only
HTML, CSS, On License jpeg images
Web
Dataturks On web Apache https://dataturks.com/ json Converts to
License 2.0 json format
but creates
single json file
for all
annotated
images
Labellmg ubuntu (o] https://mlnotesblog.wordpress.com/2017/12/ | xml Need to
Approved:: | 16/how-to-install-labelimg-in-ubuntu-16-04/ install
MIT dependencies
License given in
reference
Dataset_ Ubuntu 2018 https://github.com/omenyayl/dataset- json Need to
annotator George annotator install
Mason app_image
University and run it by
Permission changing
is hereby permissions
granted,
Free of
charge
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References

e Google TensorFlow Object Detection GitHub

e  Pretrained TensorFlow Model for Object Detection
e  Python Sample Code for Custom Object Detection
e Train Model Using TensorFlow
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Technical Support Assistance

Submit a technical support case through www.latticesemi.com/techsupport.
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Revision History

Revision 1.0, May 2020

Section Change Summary

All Initial release.
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